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INTRODUCTION

Introduction
Thank you for purchasing E-Z KENNEL PLUS. In this document you will find 
instructions for use of the program. E-Z KENNEL PLUS is very easy to use, if 
you are familiar with other windows programs you will feel right at home. If 
you don't know much about computers you will be amazed at how easy it really 
is. I think you will really enjoy the new features in this version. This 
User's Manual should contain about anything you want to know about what you 
can do in the program. But please feel free to contact us should you have 
any questions.

This program was designed for the dog owner/breeder who wants to keep 
accurate, up to date records. The forms you use in this program contain 
fields to hold all of the information required by All Registries, USDA, 
State agencies and more to the best of our knowledge as of the date of this 
release. I hope you like the program and I always appreciate input from 
users of the program. Please feel free to call, fax, e-mail or send comments 
or questions to me at the address in the Technical Support Section.

Copyright Notice
E-Z KENNEL PLUS and this document are copyrighted.
This software is owned by Stacy L. Chapman, dba Chapman Pet Programs and is 
protected by United States Copyright laws and international treaty 
provisions. You may not reverse engineer, decompile, disassemble, or create 
derivative works from the software.

License Agreement
You are permitted to use this program on one computer, to maintain records 
for one person/kennel. Ownership of this program is not transferable. When 
using an upgrade the ownership of all previous versions must also be 
retained. This program may be distributed to others for use as a demo only, 
as long as it is copied from the original disks, distributed with all files 
contained on the original disks and used only for the Trial period. The need 
to call and get a registration code for permanent use is the method we have 
been forced to use to prevent dishonest people from sharing the software. We 
apologize for the inconvenience to the honest people. We need for everyone 
who uses the program to pay for it in order to keep providing updates and 
support for the software.
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Disclaimer
THE SOFTWARE AND MANUAL ARE PROVIDED "AS-IS". I disclaim all warranties 
relating to this software or manual, whether express or implied, including 
without limitation any implied warranties of merchantability or fitness for 
a particular purpose. I will not be liable for any incidental, 
consequential, indirect or similar damages due to loss of data or any other 
reason. The user assumes the entire risk as to the accuracy and use of this 
product. This agreement shall be governed by the laws of the State of 
Illinois, and any legal action brought in a State or Federal Court of 
competent jurisdiction located in Adams County, Illinois. The parties hereby 
consent to jurisdiction of said courts.

I AM NOT RESPONSIBLE FOR LOST DATA. You should make regular back-ups of your 
data. See the "Making Back-ups" section for details.

Limited Waranty
To the registered User only, Chapman Pet Programs provides the following 
warranty: For a period of ninety (90) days from the date of purchase, as is 
evidenced by a copy of your receipt, that: 
(1.)The Software, unless modified, will perform substantially the functions 
described in the User's manual provided as a Pdf file on the Software CD by 
Chapman Pet Programs.
(2.) The Software media provided will be free from defects in material and 
workmanship under normal use.

Assumptions
This book assumes that you are familiar with the windows operating system 
that you are using. We will try to explain the use of features in the 
program as best we can, but it is your responsibility to know how to use the 
basic functions of the Windows operating system you are using.
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SYSTEM REQUIREMENTS & INSTALLATION

System Requirements
This program requires an IBM compatible Pentium PC or higher computer with a 
minimum of 36MB of RAM, a hard drive with at least 15M of free space, 
Windows 98 or above, a Mouse and a CDROM drive.  More hard drive space will 
be required if you are adding pictures and logos. The program may be useable 
on some PCs that don't meet these requirements but it is not recomended or 
supported.

Installation
1. Start your computer
2. Insert the CD, If installation starts automatically skip to step 6.
3. Click on the START button and select RUN
4. Type X:\Setup in the Command line Box (Replace the X with your CDROM 
drive letter)
5. Choose the OK button
6. Follow the On Screen instructions
7. Register the software as described below in section 3.
8. Read the "Dates and Y2K Compatability" section... NECESSARY EVEN IN NEW 
PC's
9. Read the Quick Start Guide before you begin entering records.

Product Registration
It will be necessary for you to register the software in order to continue 
use after the Trial period. To Register the software you must contact us to 
receive your Product Registration Code. When you call you will need to have 
the correct 5 digit system number that is displayed in the E-Z KENNEL PLUS 
registration form that appears when you open the program. Once the 
registration code has been entered, you will not be prompted again. Every 
Computer has a different system number even if the program is installed from 
the same cd. Be sure you give us the correct system number from your 
computer when you call to register.
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Dates and Y2K Compatability
THE OK SOLUTION:
When entering dates for the year 2000 or later it is necessary to enter all 
4 digits of the year such as 2000 rather than just the 00. Entering 00 will 
actually store the date as 1900. The easiest way to know that the correct 
date is being entered is to make sure that you have changed your computer's 
short date format so that you will be able to see all 4 digits of the year. 
This is done by going to: Start, Settings, Control Panel, Regional Settings, 
select the Date tab in the Regional Settings. Change the Short Date Format 
there to m/d/yyyy.

THE BEST SOLUTION:
Many people find it annoying to have to enter all 4 digits of the year. If 
you make the following change in your win.ini file you will be able to enter 
just the 2 digit years and it will be saved correctly 
*Open the C:\Windows\Win.ini file in any text editor, such as Notepad.
*Scroll down to the end of the Win.ini file, and then type the following 
lines at the end of the Win.ini file:

[Microsoft Access 2.0]
TwoDigitYearMax=2029

IMPORTANT: These lines must be entered exactly as shown.  If they are not, E-
Z KENNEL PLUS will assume that the two-digit years fall within the 1900s. 
Save the changes by choosing Save from the File menu and then close the file 
and Restart your computer.

Resizing the Forms
The size of the forms and reports on your screen will depend on your screen 
resolution settings. 
The program is best viewed on a screen resolution of 1024 x 768. 
Lower settings will make forms larger than the screen and you will have to 
scroll around to see everything on a form. 
On the other hand if you set the resolution too high the forms will only use 
a small area on the screen and the text on the forms may be very small and 
hard to read. You will need to adjust it to suit you within the ability of 
your computer. 
At 1024 x 768 on a 17 or 19 inch monitor you will be able to see all of a 
form at once and most forms will use the majority of the screen and be easy 
to read.

To make changes to your screen resolution you can right click on your 
computers Desktop and choose Properties. In the Properties you click on the 
Settings Tab and change the resolution there.
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PROGRAM BASICS

Definitions
Here are a few common definitions or computer terms you should know.
It is important to know a few computer terms so that you can correctly 
identify things on your screen.  This is extremely helpful (and saves you 
money) if you are going to telephone someone for help with a problem and 
they are not able to see your computer! Phone time can be reduced 
drastically. It is also helpful if you can describe exact problems by 
writing down messages that appear and exactly what happened or what you were 
doing when you had the problem.

Computer Terms
The Chart below contains some computer terms that you should know.
Active Window The window on your screen that has the focus. Usually the 

one that is on top (covering) anything else on the screen.
Click To press and release the left button on the mouse 1 time.
Clipboard The invisible space on your computer that stores things 

for you until you need them or replace them with 
something else.

Current Record The record that is visible on the form, or the record 
your cursor is in.

Cursor The little " I " line that blinks to let you know where 
you are on the screen.

Desktop The background area of your screen.
Dialog Box A small form that pops up with available choices for 

various tasks.
Field A box or place designed for a particular piece of 

information.
Field Selector The gray bar at the top of a column in a datasheet.
Form A screen or Window where you view or edit information.
Icon, Shortcut A small square with a picture on it, usually found on 

your desktop. When you doubleclick an icon it usually 
opens a program.

Menu A list of options.
Menubar The row of words along the top of the window containing 

words like File, Edit, View... (when you click on one it 
opens a menu)

Navigation Bar The small bar at the bottom right corner of a form 
window, containing 4 buttons and Record x of x.

Re-Boot Simply means to shut the computer off and turn it back on.
Reformat This is when you erase all data, programs and settings 

from the hard drive and usually includes reinstalling 
them as it was when new.

Record Selector The gray block on the left side of a record in a form.
Required Data Means data must be entered in a specified field in order 

to continue or to save the record.
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Right Click To click with the right mouse button, rather than the 
left button.

Selection The highlighted text or records. Can also be the current 
record.

Subform A form within a form. Such as a vaccination record on a 
litter record.

Title Bar The colored bar across the top of a Form, Report or 
Program Window that usually contains the objects name or 
a description.

Unique One of a kind or only used once.

The Menubar
The Menubar is located at the top of the program screen on the left side 
just below the programs title bar. The Menubar Contains the names of the 
Menus that are available. Click on a Menu to display a list of Command 
choices as described below. Note: Some commands are not always available.

Menubar, File Menu
Commands on the File Menu.
Close Closes the form or report you are using.
Save Form Saves any changes you have made to the forms print setup 

or datasheet view formatting.
Save Record Saves any changes you have made to the record you are 

entering or editing. Note: Changes to Records are 
automatically saved when a form is closed or when you 
move to another record.

Output To Opens a Dialog Box for selecting options to output 
records in various other file formats.

Export Opens a dialog box for selecting Export options.
Print Setup Opens the Print Setup dialog box where you choose various 

printing options. See "Printing"
Print Preview Opens the print preview window to show you what the 

current form or report will look like when printed. See 
"Printing"

Print Opens the Print Dialog box to select print options. See 
"Printing"

Send Opens the Send Dialog Box to select options for sending 
your records using other applications

Exit  Exits the E-Z KENNEL PLUS program.

Menubar, Edit Menu
Commands on the Edit Menu.
Undo Use this command to undo the last thing you done. You may 

also press the ESC key 1 time to undo changes in a single 
field or 2 times to undo changes in an entire record.

Undo Current 
Record

Use this command to undo changes made to the entire 
record. You may also press the ESC key 2 times.

Cut Remove the selected text or record and puts it on the 
invisible clipboard.
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Copy Makes a copy of the selected text or record (highlighted) 
and puts it on the clipboard.

Paste Puts a copy of whatever is on the invisible clipboard 
into the field where you have your cursor. When pasting 
an entire record you must first choose Edit, Select 
record and then Edit, Paste.

Paste Special Has more detailed choices for how you want to paste.
Paste Append Use to Paste a complete record to a form.
Delete Deletes the current field, the selected text or the 

selected record.
Select Record Selects the current record so that you may print it, 

delete it or Paste another record into it. Records can 
also be selected by clicking on the gray bar to the left 
of the record if it is available.

Select All 
Records

Selects all of the records in the current form so you may 
print, delete them or whatever.

Find Opens the Find Dialog box used to do a search. You may 
also open this Dialog box by pressing the " F7" key on 
the keyboard.

Replace Opens the Replace Dialog box. You may also open this 
dialog box by pressing (Shift + "F7")

Insert Object Opens the Dialog box where you select the object you want 
to put in the picture frame on the Dogs record. (like a 
picture file).

Links Manage or update the link to a picture or whatever you 
put in the picture frame if you chose to link it.

Object Manage or update the object in your picture frame from 
within the program.

Menubar, View Menu
Commands on the View Menu.
Form View the current form in Form View.
Datasheet View the current Form in Datasheet View. (Rows and 

Columns of data)

Menubar, Format Menu
Commands on the Format Menu. (Available only in Datasheet Views)
Font Opens a dialog box to change the Font properties.
Row Height Opens a dialog box to change the Row Height.
Column Width Opens a dialog box to change the column width.
Hide Columns Hides the selected columns.
Show Columns Opens a list of all available columns for you to select 

which ones you want to be visible.
Freeze Columns Freezes Selected columns so that when you scroll across 

the datasheet these columns will remain in view.
Unfreeze All 
Columns

Does just that.

Gridlines Toggles the gridlines of the datasheet Off/On.
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Menubar, Records Menu
Commands on the Records Menu.
Go To Offers you a choice of going to the First, Last, Next, 

Previous, or a New record in the current Form.
Refresh Refreshes the form to show any changes or to do 

recalculations of any calculated field.
Quick Sort Allows you to sort the records in the current form in 

Ascending or Descending order according to the field that 
your cursor is in when you choose this command.

Show All Records Use this command to view all of the records after a 
filter has been applied and some records have been hidden.

Menubar, Help Menu
Commands on the Help Menu
Help Topics Displays the Help Topics Menu to choose and view Help 

information.
About Opens the About E-Z KENNEL PLUS screen.

The Toolbar
The Toolbar is located at the top of the program screen on the left side 
just below the programs Menubar. The Toolbar Contains Buttons that perform 
the Command choices as described below. Note: Some Buttons are not always 
available.

Toolbar Buttons
Toolbar Button commands.
Form View Displays the form in Form View.
Datasheet View Displays the form in Datasheet View.
Print Setup Opens the Print Setup dialog box where you choose various 

printing options. See "Printing"
Print Preview Opens the print preview window to show you what the 

current form or report will look like when printed. See 
"Printing"

Print Opens the Print Dialog box to select print options. See 
"Printing"

First Record Moves to the First Record in the Form.
Previous Record Moves to the Previous Record in the Form.
Next Record Moves to the Next Record in the Form.
Last Record Moves to the Last Record in the Form.
Save Record Saves any changes you have made to the record you are 

entering or editing. Note: Changes to Records are 
automatically saved when a form is closed or when you 
move to another record.

Undo Current 
Field/Record

Use this command to undo the last thing you done. You may 
also press the ESC key 1 time to undo changes in a single 
field or 2 times to undo changes in an entire record.
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Cut Remove the selected text or record and puts it on the 
invisible clipboard.

Copy Makes a copy of the selected text or record (highlighted) 
and puts it on the clipboard.

Paste Puts a copy of whatever is on the invisible clipboard 
into the field where you have your cursor. When pasting 
an entire record you must first choose Edit, Select 
record and then Edit, Paste.

Find Opens the Find Dialog box used to do a search. You may 
also open this Dialog box by pressing the " F7" key on 
the keyboard.

Sort Ascending Allows you to sort the records in the current form in 
Ascending order according to the field that your cursor 
is in when you choose this command.

Sort Descending Allows you to sort the records in the current form in 
Descending order according to the field that your cursor 
is in when you choose this command.

Font Opens a dialog box to change the Font properties for a 
Form's Datasheet View. Note: Fonts can not be changed for 
the Form View of a Form.

Show Hidden 
Columns

Opens a list of all available columns for you to select 
which ones you want to be visible.

Help Topics Displays the Help Topics Menu to choose and view Help 
information.

Navigation
Moving around in the program.

Opening Forms and Reports
The Forms are opened by choosing the appropriate button on the Main Menu or 
another related form or menu. For More information about specific forms 
refer to the "Forms and Reports" section of the User's Manual.

Moving from Record to Record in a Form
There are several ways to move through the records on a form.
There is a navigation bar available at the bottom of most forms and 
navigation buttons on the Toolbar and also sometimes at the top of the Form. 
(See Chart Below)
There are navigation commands on the "Records" menu of the menubar. 
The "Go To" list fields available on some forms take you directly to a 
selected record. 
There is a Find button on the Toolbar and a Find Command on the Edit Menu 
that can be used to locate specific records. See the "Find" section of the 
Help Topics or the User's Manual for more information about searching for 
specific records.
First Moves you to the First Record in the Form.
Previous Moves you to the Previous Record in the Form.
Next Moves you to the Next Record in the Form.
Last Moves you to the Last Record in the Form.
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Moving from Field to Field in a Record
All of the forms have a preset Tab order. The cursor blinks in the field 
that you are in. Press enter or Tab to move to the next field, or use your 
mouse to select the field you wish to move to by clicking on it. In some of 
the fields with more than one line of text possible, the enter key will move 
to the next line in the same field. Use the tab key to leave those fields. 
In some cases you may use the arrow keys to move from field to field. See 
the Hotkeys section for other usefull navigation tips.

Moving from Page to Page on a Report
When Reports are displayed they are always in Print Preview. In Print 
Preview the Navigation Bar at the bottom of the report will show the page 
you are on and allow you to use the buttons to move to other pages. 

BUT... In a Print Preview the navigation bar does not show you the total 
number of pages. To see how many pages there are in the report you have to 
click on the button to move to the last page and then look at the page 
number. You can print all or just selected pages of a report.

Entering and Editing Data
Basic Data Entry for forms in the program.

Entering New Records
Not all forms allow entering or editing, some forms are for viewing or 
printing only, in those forms you will not be able to edit or enter any 
information. Those types of forms take data from other records in the 
program. Just open a form's Help Topic for details.

To enter a new record in a form you must first go to a new record in one of 
the following ways.

1.)Choose GoTo/New from the Records Menu.
2.) Click the "NEW" button on the form (if available).
3.) Scroll to the last record and click the next record button on the 
navigation bar.
4.) Move to the record with an( *) in the record selector bar at the bottom 
of a datasheet view , or in a subform of a Form.
 
Once in a new record, simply enter the desired info.
Views When you open a form you will be in the "Form View" of 

the form.  Many Forms also have a "Datasheet View" 
Avaialble. You may enter or edit records in either view 
if the form is designed for entering or editing. The 
"Form View" is usually easier to use when entering new 
records but the "Datasheet View" allows you to see 
multiple records at once.
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Fields with a 
Dropdown List

In these fields you can begin typing until the desired 
entry appears, this is called quickfill or click the 
arrow key at the right end of the field (or press "F4") 
to display a list of available entries. Click the one you 
want from the list or hit enter when the quickfill 
matches the entry you want.  In some of the list fields 
you may type in what you want even if it is not in the 
list, and some of them require you to choose an entry 
from the list.

Saving a Record Records are automatically saved when you move to a 
different record or close the form. You will receive a 
message if there is a reason the record can't be saved. 
For example if you have entered a Dog Id# or Reg. # that 
has already been used you will see a message telling you 
so. You may also select "Save Record" from the "File" 
Menu or the Save Record button on the Toolbar.

Editing Records
To edit a record, simply go to the record you would like to modify and make 
any desired changes. 
The changes you have made will automatically be saved when you move to 
another record or close the form. If you change your mind before the record 
is saved you may use the Undo Button on the Toolbar or press ESC to back out 
of the changes in a field or press ESC 2 times to undo all changes made to 
the record.
Not all forms allow changes to the records. Some Forms are just for 
printing. Click the Help button on a form to see if the records can be 
changed on the form and, if not, where to change the records.

Selecting Records
To Select a record choose Edit, Select Record from the Menubar or in 
datasheets and in some forms you can click the gray bar (record selector)to 
the left of the record to select it.  

Knowing how to select a record is important if you want to print or delete 
only a selected record.

Note: Be very careful not to choose "Select All Records" to delete unless 
you actually intend to delete all of the records in the form you are on and 
in all related forms. For example if you are in the Dog Records form and you 
choose Edit, Select All Records and then Delete you will delete ALL of the 
dogs along with their records from the entire program...
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Deleting Records
Some Forms have a button on the top of the form that you can use to 
automatically delete the record you are on. Otherwise to delete a record in 
a form or datasheet select the record or records you want to delete then 
from the Edit menu, choose Delete (or press the DEL key). If you don't 
select the record first you will just be deleting data from the visible 
fields and a blank record will still be there and you could get a message 
that certain fields are required. Press ESC 2 times to put the record back 
as it was and then select the record and Delete it. If you are entering a 
new record that has not been saved yet and change your mind just Press Esc 2 
times to back out of it rather than delete it.

Note: Be very careful not to choose "Select All Records" to delete unless 
you actually intend to delete all of the records in the form you are on and 
in all related forms. For example if you are in the Dog Records form and you 
choose Edit, Select All Records and then Delete you will delete ALL of the 
dogs along with their records from the entire program...

Copying Records
To copy a record
1.) Open the form and record that contains the data you would like to copy.
2.) Click on Edit, Select Record from the menubar to select the entire 
record. Note:It may not become highlighted but it is still selected.
3.) Click on Edit, Copy from the menubar. This copies the entire record to 
the invisible clipboard.

We have added special copy and paste buttons to the Continue Sire and 
Continue Dam Pedigree sections to simplify this process for you so that you 
do not have to use the steps above to copy and paste those records.

Pasting Records
To paste a record 
1.) Open the empty record that you would like to paste the data into.
2.) Click on Edit, Select Record.
3.) Click on Edit, Paste.

We have added special copy and paste buttons to the Continue Sire and 
Continue Dam Pedigree sections to simplify this process for you so that you 
do not have to use the steps above to copy and paste those records.

Hot Keys
Hot Keys are keys or key combinations you can use to perform useful tasks 
when working in forms. Some tasks have more than one key or key combination 
that will work. In that case use the one that you find easiest to use or 
remember.  If you take the time to get familiar with the Hotkeys you'll find 
they can save you a great deal of time.

The Chart below shows the Hotkeys that are available in this program.
Tab, Right 
Arrow or Enter

Moves to the next field. Note: Sometimes the Enter key 
will just move to the next line in the same field.

Shift & Tab or 
Left Arrow

Moves to the Previous Field.

Home Moves to the first field in the Record.
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End Moves to the Last field in a Record.
PgDn Moves to the Next Record in a Form or to the portion of 

the form that is hidden if the form expands beyond the 
size of the form window.

PgUp Moves to the Previous Record in a Form or to the portion 
of the form that is hidden if the form expands beyond the 
size of the form window.

Ctrl & + Moves to a New Record.
Ctrl & - Deletes the Current Record.
Shift & Enter Saves changes to the current Record.
F4 or Alt & 
Down Arrow

Drops down the list for the current field when available.

Note: use the Up and down arrow keys to move up or down 
in a fields list and the tab to close the list and go to 
the next field.

Ctrl & ; Inserts the Current Date into the field you are in.
Ctrl & ' or 
Ctrl & "

Copies the value from the same field in the previous 
Record.

F7 or Ctrl & F Opens the Find Dialog Box.
Shift & F7 or 
Ctrl & H

Opens the Replace Dialog Box.

Shift & F4 Finds the next occurence of the text specified in the 
Find or Replace Dialog Box, AFTER THE DIALOG BOX HAS BEEN 
CLOSED.

Accelerator Keys
Accelerator keys are used in place of the mouse click. The keys available 
will vary. You will know what keys you can use by looking for letters that 
are underlined on the menubar and the commands available from the menu bar. 
To use an accelerator key you simply hold down the "Alt" Key while pressing 
the Underlined letter of the command.
For example to choose "Print" from the "File" Menu you would press (Alt + F) 
to display the File Menu and then (Alt+P) to display the Print Dialog box.

Filtering and Sorting Records
Applying Filters and Sorting your records.
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Filtering Records
What is a Filter?
A filter is a method of temporarily removing records from a form so that you 
may view, edit or print only a certain set of related records. For instance 
you may Choose the Filter by Breed for the Dog Records and select a Breed so 
the records in the form will change to include only the records for the 
breed you selected.
To Apply a filter...
There are built in filters for some of the forms and Filter buttons 
available to choose from. Just choose the desired filter to apply it.
To Remove a Filter...
When not all of the records are being displayed in a form, you may choose 
"Show All Records" from the "Records" Menu to cause the form to include all 
of the records. On some of the forms there are "Filter" Buttons which give 
you a choice of filters to apply.

See the "Forms and Reports" section of the User's Manual to find out what 
filters are available for specific forms.
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Sorting Records
What is Sorting?
When you sort records you do not change or remove any of the records 
displayed, you simply put them in a different order.

You can sort records in Form or Datasheet View into a different order than 
they are usually displayed by using the Toolbar buttons or the Quick Sort 
command.

Each form when open will automatically sort the records it contains into an 
order that is built into that form. You may re-order the records by sorting 
them.

In a form, you can sort the contents of only one field at a time; in a 
datasheet, you can sort the contents of one, two or three adjacent datasheet 
columns in a single operation. If you select more than one column, E-Z 
KENNEL PLUS sorts records starting with the leftmost column.

You can sort records for display in either ascending or descending order, 
and you can sort by any field on the main part of a form except one with the 
Memo or OLE Object (picture) data type. 

Ascending means records are sorted from A to Z and 1 to 10 while descending 
means from Z to A and 10 to 1.

To sort records
1. In a form, select the field you want to sort. (just click in the field) 
In a datasheet click in, or select the column or columns you want to sort.
2. Choose the appropriate Toolbar button or choose Quick Sort from the 
Records menu, and then choose Ascending or Descending.

For example: if you would like to see your Dog Records in order by Date of 
birth and see the oldest ones first, you would do this: 
1.) Open the Dog Records - Entry form. 
2.)In the first record you see, click anywhere in the Date of Birth field, 
so that your cursor is blinking in that field. 
3.) With your mouse, click on the "Sort Ascending" Button on the toolbar or 
click on the "Records" menu and choose "Quick Sort" and then "Ascending".

Sorting Two or Three Columns in a Datasheet

Suppose you're viewing the Dog Records Form and you want to see the dogs 
sorted by Breed. Within each Breed you want to sort records by Sex, arrange 
columns in the datasheet so that the Breed column is directly to the left of 
the Sex column. (See the appropriate sections for more information on moving 
and selecting datasheet columns) 
Select the Breed and Sex columns, and then click the Sort Ascending button 
on the toolbar.  E-Z KENNEL PLUS sorts records first by Breed then by Sex. 
Records are sorted by values in the Breed and within each Breed the Sex are 
sorted.

Search, Find and Replace
Locating specific information.
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Finding Records
To locate a particular record you have several options.
* You may use the buttons on the navigation bar or the Toolbar to simply 
scroll through the records.
* You may use the "GO TO" list box at the top of the form when available to 
pick the record you would like to see.
* Or you may want to search for a particular record according to data in a 
single field.

Finding Data
When you want to find a specific record or find certain values within 
fields, you can use the Find command to go directly to a specific record. 
You can also use the Find command to navigate through records and find one 
record after another. The Find dialog box always stays on top of your form 
or datasheet until you choose the Close button.

To make searches faster, E-Z KENNEL PLUS searches only the current field 
unless you select the All Fields option in the Find dialog box

To find a specific value in a field
1.Move the cursor to the field where you want to search.
2.Choose the Find button on the Toolbar, choose Find from the Edit menu or 
click the "F7" key on the keyboard to open the Find Dialog Box.
3.In the "Find What" box, type the value you want to find. 
4.Choose the Find First button or press the ENTER key.
Note: In Windows XP you may need to use the "Find Next" button instead of 
the "Find First" button.
E-Z KENNEL PLUS moves to the record (if it exists). You may have to move the 
Find dialog box out of the way to see the record.
5.Choose the Find Next button to find the next occurrence of the specified 
value.
-Or-Choose the Close button to close the dialog box.

Tip: After you close the Find dialog box, you can always find the next 
occurrence of the value you most recently searched for by pressing SHIFT+F4.

For Example, you get a letter from AKC requesting information concerning a 
litter and all they provide you with is the litter number. You would do this:
1.) Open the Litter Records - Entry form.
2.) In the First record you see, click on the Litter # field so that your 
cursor is blinking in this field (don't change this record)
3.) Open the "Find" dialog box, by selecting the "Find" button on the 
Toolbar, pressing the "F7" key or selecting "Find" from the "Edit" menu.
4.) In the "Find" dialog box, enter the litter # you want to go to, (like: 
wp123456/)
5.) Select the "Find First" button or simply hit the Enter key.
This will take you immediately to the desired record. You would close the 
Dialog Box as it will stay on top if left open. If there is more than one 
record in the form that contains the same information, you may open the 
"find" Dialog box again, and Select the "Find Next" button or press the Hot 
Key Combination (Shift + F4) to move to the next record which matches the 
criteria entered.
Note: In the "Find" dialog box there are options available that you may 
select, such as search for "Any Part of Field" this would allow you to for 
example enter part of a Dogs Registered name and find all records that 
contain what you have entered.
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Find Options
When you use the Find command, you can choose several options to tell E-Z 
KENNEL PLUS how to find the data you want.

Searching in All Fields
E-Z KENNEL PLUS usually searches only the current field, because it's 
fastest to search in just one field. However, if you want E-Z KENNEL PLUS to 
find values in any field in a form or datasheet, select the All Fields 
option in the Search In option list.

Finding Text Within Fields
E-Z KENNEL PLUS usually searches whole fields, not the partial contents of 
fields (Match Whole Field is the fastest type of search). If you want E-Z 
KENNEL PLUS to look within each field for certain text, select Any Part Of 
Field from the Where list. For example, you might want to find any field 
containing a certain word. E-Z KENNEL PLUS finds each occurrence of the text 
you specify, even if the text occurs more than once in the same field.
If you know that the text you are looking for is at the beginning of a 
field, select Start of Field from the Where list to make the search faster. 
For example,, you may want to search for a certain first name at the start 
of a field that contains first and last names.

Matching Case
Usually, E-Z KENNEL PLUS searches text regardless of whether it's uppercase 
or lowercase. For example, E-Z KENNEL PLUS finds "Tom" whether you specify 
"tom" or "TOM." If you want E-Z KENNEL PLUS to find only the exact text you 
type, select the Match Case option
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Replacing Data with the "Find and Replace" Command
Sometimes you must make the same change to your data in several places. If 
you want E-Z KENNEL PLUS to find occurrences of specific text and replace 
them with different text, you can use the Replace command. With the Replace 
command, you can look at each occurrence of the specified text before you 
make the change, or you can make global changes. To make searches faster, E-
Z KENNEL PLUS searches only the current field unless you select the All 
Fields option in the Replace dialog box.

To find and replace all occurrences of specified text
1.Move to the field where you want to search and replace.
2.From the Edit menu, choose Replace.
3.In the Find What box, type the text you want to find.
4.In the Replace With box, type the replacement text.
5.Choose the Replace All button.
E-Z KENNEL PLUS prompts you to confirm the changes you made with the Replace 
command.
6.Choose the Close button to close the dialog box.

To find and replace occurrences of specified text one at a time
I.Move to the field where you want to search and replace.
2.From the Edit menu, choose Replace.
3.In the Find What box, type the text you want to find.
4.In the Replace With box, type the replacement text.
5.Choose the Find Next button.
E-Z KENNEL PLUS moves you to the next occurrence of the text you specified 
and selects it. You may have to move the Replace dialog box out of the way 
to see the record.
6.To replace the specified text and move to the next occurrence, choose the 
Replace button. E-Z KENNEL PLUS doesn't prompt you to verify that you want 
to change the contents of a single field.
-Or-To leave the selected text as is and find the next occurrence instead, 
choose the Find Next button again.
7.When you finish replacing, choose the Close button to close the dialog box.
For example: if you have all of your Shelties entered in the program as 
Sheltie and you realize that they should have been entered as Shetland 
Sheepdogs, You would change the Name in the Breeds List and then to Change 
each dogs breed entry, do this:
1.) Open the Dog Records - Entry Form.
2.) Select "Show All Records" from the "Records" menu.
3.) Click on the Breed field in the first Record you see.
4.) Select "Replace" from the "Edit" menu. or use the Hot Key Combination 
(Shift + F7) to open the "Replace" dialog box. Enter the word "Sheltie" as 
the text to Find and enter the words "Shetland Sheepdog" as the text to 
Replace it with.
5.) Select the "Replace all" button to replace all of the Shelties with 
Shetland Sheepdog.
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Find, Using wildcard characters
Using Wildcard Characters
When you use the Find and Replace commands, you may not always know exactly 
what you are searching for. For flexibility, you can use the question mark 
(?), the asterisk (*), and the number sign (#) as wildcard characters in the 
Find What box in either the Find or Replace dialog box.

A question mark stands for any single character in the same position as the 
question mark. An asterisk stands for any number of characters in the same 
position as the asterisk. A number sign stands for a single numeric digit in 
the same position as that numeric digit (useful when you want to find a 
number, but not a letter).

You can use characters in square brackets to find one of several characters. 
For example, to find the letter Q or X' type [QX]in the Find What box. You 
can indicate ranges of characters with a hyphen. For example, to find any 
letter between A and Z, type [A-Z]. You can specify characters you don't 
want to find by including an exclamation point (!) after the first bracket. 
For example, to find all characters except the letter M, type [!M].
The chart below shows some examples of how to use wildcard characters.
If you search 
for this...

E-Z KENNEL PLUS finds this...

Sm?th Smith, Smyth
L*ng Ling, Leveling, Leka Travel and Trading...
#th 5th, 8th, 128th…
*th Birth, Path...
Paul[ao] Paula or Paulo
Paul[!ao] Pauli (but not Paula or Paulo)

Note If you want to find one of the wildcard characters 
itself, enclose it in square brackets. For example, to 
find the value "#1", type [#]1.

Form Buttons
There are buttons on many of the forms to perform common tasks.

Form Buttons
Form Button Commands. 
Note: Not all of the buttons shown here are available on all of the Forms in 
the program.
Close Use this button to close the form.
Add a Record Use this Button to add a new record.
Delete a Record Use this button to delete the record you are on.
Print Use this button to print the record you are on (on some 

forms like the Income and Expense records that resemble a 
list it prints all of the records).

Filters Use this button to open the built in filters available 
for a form.

Show All Records Use this button to remove any filters or to shows all 
records.
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On Hand Use this button to show the records for all Dogs or 
Puppies on Hand.

Previous Record Use this button to move to the Previous Record.
Next Record Use this button to move to the Next Record.
Help Use this button to open the Help file for the form.
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DATASHEET VIEWS

Changing to Datasheet View
Getting to the Datasheet view of a Form.
To change to Datasheet view, you can click on the Datasheet View button on 
the Toolbar or select View, Datasheet from the menubar.

Customizing a Datasheet
Changing the Layout (Look) of a Datasheet.
E-Z KENNEL PLUS provides several ways for you to change the display of a 
datasheet. You can change the width of individual columns to fit the field 
values they display. You can re-order, hide, or freeze columns. And you can 
change the row height and font.
When you save or close a form, E-Z KENNEL PLUS asks if you would like to 
save changes to the form.  This includes appearance of the datasheet as well 
as any changes to the Print Setup. If you choose yes, the next time you open 
the datasheet, it appears just the way you left it. Also any print settings 
will be as you saved them.

Resizing Columns in Datasheet View
Column witdths do not all have to be the same in a Datasheet.

To manually change the size of a column to the desired width... 
1.) Position the mouse pointer at the right side of the field selector for 
the column you want to resize. The field selector is like the heading at the 
top of the column. The mouse pointer will change to a vertical line with 
horizontal arrows when you have it positioned correctly in the field 
selector to resize the column.
2.) Hold down the mouse button and drag the column border to the desired 
size.

There are also 2 ways to resize a column to automatically fit the data it 
displays.
1.)Double-click the right edge of the field selector for the column you want 
to resize.
-Or-
2.)From the Format menu, choose Column Width, and then choose Best Fit.
E-Z KENNEL PLUS sizes the column to fit the column heading and the longest 
value displayed on the screen in the column (not necessarily the longest 
value stored in the field).
Tip: To resize multiple columns at once, select the columns you want to 
resize (or the entire datasheet), then drag or double-click the right edge 
of any one of the field selectors. E-Z KENNEL PLUS sizes all the selected 
columns to fit the data displayed.

Also you can make columns narrower to allow more columns on a printed page 
and make the rows taller so that the text in the fields can use 2 lines 
rather than be cut off.
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Resizing Rows in Datasheet View
Note: Any changes to Row height or Fonts will affect all Rows in the 
datasheet.
Sometimes it is much easier to read a datasheet if the lines are not so 
close together so you may want to make the row height taller just so things 
don't look so cramped.
Also you can make columns narrower to allow more columns on a printed page 
and make the rows taller so that the text in the fields can use 2 lines 
rather than be cut off.

To manually change the size of the rows to the desired height... 
1.)Position the pointer between any two of the record selectors at the left 
side of the datasheet. The record selector is like a gray block on the Left 
side of the Row. The mouse pointer will change to a Horizontal line with 
vertical arrows when you have it positioned correctly between the record 
selectors to resize the rows.
2.) Hold down the mouse button and drag the line to the desired height.
All rows in the datasheet change to the new row height.

Moving Columns in Datasheet View
1. Select the column you want to move by clicking the field selector (column 
header). To select multiple columns just hold down the SHIFT key on your 
keyboard and select the column(s) you want.

2. Click on the field selector again, hold the button down and drag the 
column to its new position and then release the button to drop it there. As 
you drag the column, its destination is indicated by a solid bar between the 
other columns.

Hiding or Showing Columns in Datasheet View
Since you often have more fields in a form's datasheet than can fit accross 
a page, you might want to view or print only certain columns. 
For example, In the Datasheet View of the Dog Records form you might want to 
print a list of the dogs you have including only the Breed, Sex, Dog's Name 
and Registration numbers without all of the other info.

To hide a column in a datasheet

1. Select the column or columns you want to hide by clicking the field 
selector(s).
2. From the Format menu, choose Hide Columns.

To show columns that have been hidden in a datasheet

1. From the Format menu, choose Show Columns. You will see a list of the 
fields and be able to place a check mark next to all fields you want to show 
on the datasheet.
2. Select the column(s)(fields) you want to show and then choose the Show 
button.
3. Close the dialog box and the fields you chose will be on the datasheet.

Note: You may also uncheck any fields that you don't want to show and they 
will be hidden in the Datasheet when you close the Dialog box.
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Freezing or Unfreezing Columns in Datasheet View
Freezing and Unfreezing Columns

In a Datasheet there are usually too many columns to view them all on the 
screen at once so you have to scroll over to see some of the columns.
When you freeze a column it remains visible on the left side of the 
datasheet even when you scroll to see other columns. The columns that are 
not frozen will just slide behind the frozen columns as you scroll rather 
than off of the left side of the screen. 
So if you want one or more columns to be visible at all times, you can 
freeze those columns. When you scroll through a datasheet horizontally to 
view columns to the right, frozen columns remain visible on the left. 

For example, you might want the Dog ID# to remain visible even when you 
scroll across the datasheet to see the many other fields of info for the 
dogs.

To freeze a column in a datasheet

1. Select the column you want to freeze by clicking its field selector.
To select more than one column at a time, hold down the SHIFT key and click 
the other column(s) you want to select.
2. From the Format menu, choose Freeze Columns.

To unfreeze all columns

From the Format menu, choose Unfreeze All Columns.

Changing the Fonts in Datasheet View
To change the font in a Datasheet you choose Format, Font from the Menubar 
or the Font button on the Toolbar.
You can choose any font or font size in a datasheet. If the text entered 
doesn't fit in the columns of a datasheet, you can change the row height to 
display more than one line of text in each row. 
In other words, you can make columns narrower to allow more columns on a 
printed page and make the rows taller so that the text in the fields can use 
2 lines rather than be cut off.

Changes to font or row height affect the whole datasheet, not individual 
rows.

Note: Changing the fonts in a Datasheet View does not affect the Form View. 
Fonts can not be changed for forms in Form View.

Working in a Datasheet
Entering and Editing Records in a Datasheet.
Remember that a Datasheet is just another way to view the records in a Form. 
When you add, change or delete records in Datasheet View they are added, 
changed or deleted in the Form View also...
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Entering New Records in Datasheet View
You can add records to a form in it's Datasheet View if the form is designed 
for entering records. If the form is for printing only then you will not be 
able to add records in the Datasheet View either. If the form contains one 
or more subforms the fields on the subform are not included in the datasheet 
view of the form. 

Remember that a Datasheet is just another way to view the records in a Form. 
When you add, change or delete records in Datasheet View they are added, 
changed or deleted in the Form View also...

To add a record in the Datasheet View you simply scroll to the bottom of the 
Datasheet. There will be a blank row with an asterisk in the Record Selector 
on the right edge of the row indicating it is a new record. This is where 
you add the new record. 
Once you begin adding info to the line the asterisk in the record selector 
will change to an arrow or pencil and there will be another blank line added 
below it with an asterisk in the record selector for the next new record.

Editing Records in Datasheet View
You can make changes to records on a form in it's Datasheet View if the form 
is designed for editing records. If the form is for printing only then you 
will not be able to change records in the Datasheet View either. If the form 
contains one or more subforms the fields on the subform are not included in 
the datasheet view of the form. 

Remember that a Datasheet is just another way to view the records in a Form. 
When you add, change or delete records in Datasheet View they are added, 
changed or deleted in the Form View also...

To change a record in the Datasheet View you simply scroll to the desired 
record in the Datasheet and make the changes.

Selecting Records in Datasheet View
To Select a record in Datasheet View you just click on the Record Selector 
on the left edge of the Record (a record is a row or a line).

You will need to Select a record in Datasheet View if you want to Delete it 
or Print just the specific record. 

Also if you select a record in Datasheet View and then switch back to the 
Form View you will be on the same record that you had selected in the 
Datasheet View. This is nice if you use the Datasheet View to more quickly 
locate a record but would rather edit it in the Form View...
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Deleting Records in Datasheet View
You can delete records from a form in it's Datasheet View if the form is 
designed for editing records. If the form is for printing only then you will 
not be able to delete records in the Datasheet View either. If the form 
contains one or more subforms the fields on the subform are not included in 
the datasheet view of the form. 

Remember that a Datasheet is just another way to view the records in a Form. 
When you add, change or delete records in Datasheet View they are added, 
changed or deleted in the Form View also...

To delete a record in the Datasheet View you simply scroll to the desired 
record in the Datasheet, Click on the Records Selector and then Choose Edit, 
Delete or use the Del key on the Keyboard to Delete the Record.
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PRINTING

Print Preview
Using the Print Preview.

Print Preview of a Form
You can use Print Preview to see what your form will look like when you 
print it. You can also get a close-up view of previewed data, seeing 
selected portions of text at a greater magnification. Using navigation 
buttons, you can preview page-by-page or move to exactly the page you want.

To preview a Form
Open the Form you want to preview and then choose Print Preview from the 
File Menu.
The first page to be printed is displayed in the Print Preview window. 
Although the print preview does not show the total number of pages to be 
printed you can use the buttons on the navigation bar at the bottom of the 
preview pane to move to additional pages.
To see a close-up of preview click on the section you would like to enlarge.
You can read the text by getting a closeup (zoomed) view of it. Once you've 
zoomed in, use the scroll bars to move to the top, bottom, or sides of the 
page.

To move between pages
Using the arrow buttons on the navigation bar at the bottom of the screen in 
Print Preview, you can view pages sequentially or jump to the first or last 
page in the document.

Print Preview of a Datasheet View
You can use Print Preview to see what the Datasheet will look like when you 
print it. You can also get a close-up view of previewed data, seeing 
selected portions of text at a greater magnification. Using navigation 
buttons, you can preview page-by-page or move to exactly the page you want.

To preview a Datasheet
Open the Form or Report you want to preview, switch to Datasheet View and 
then choose Print Preview from the File Menu.
The first page to be printed is displayed in the Print Preview window. 
Although the print preview does not show the total number of pages to be 
printed you can use the buttons on the navigation bar at the bottom of the 
preview pane to move to additional pages.
To see a close-up of preview click on the section you would like to enlarge.
You can read the text by getting a closeup (zoomed) view of it. Once you've 
zoomed in, use the scroll bars to move to the top, bottom, or sides of the 
page.

To move between pages
Using the arrow buttons on the navigation bar in Print Preview, you can view 
pages sequentially or jump to the first or last page in the document.
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Print Preview of a Report
Reports are automatically opened in Print preview. 
The first page to be printed is displayed in the Print Preview window. 
Although the print preview does not show the total number of pages to be 
printed you can use the buttons on the navigation bar at the bottom of the 
preview pane to move to additional pages.
To see a close-up of preview click on the section you would like to enlarge.
You can read the text by getting a closeup (zoomed) view of it. Once you've 
zoomed in, use the scroll bars to move to the top, bottom, or sides of the 
page.

To move between pages
Using the arrow buttons on the navigation bar in Print Preview, you can view 
pages sequentially or jump to the first or last page in the document.

Print Setup
Print Setup options.

Printing, Selecting a Printer
The printer you have selected as the default in your computer will 
automatically be used unless you choose another printer. To select a 
printer, you choose Print Setup from the File menu, and select the desired 
printer there.

Printing, Adjusting the Margins etc.
I.) Open the form or report to Print.
2.) From the File menu, choose Print Setup.
The Print Setup dialog box is displayed.
3.) Set the appropriate printing options such as margins and spacing. You 
may need to click on the More button to see additional options for row and 
column spacing for forms such as address labels and collar slips that can be 
printed on a variety of label layouts.
4.) Choose OK.

Most forms and reports in the program are designed to be printed on 8.5 x 11 
inch paper. Some labels, pen cards etc can be printed on various paper types 
and sizes.

Print Options
Printing options.

Printing Selected Records in a Form
To print only the selected record(s)
1.) Select the records you want to print. In a form the record you are on is 
always considered the current or selected record or you may select several 
records to print in some forms or a Datasheet.
2.) From the File menu, choose Print, the Print dialog box is displayed.
3.) In the Print Range group, choose Selection.
4.) Choose OK.
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Printing Selected Pages of a Report
In a Report you can print selected pages rather than the entire report. Open 
the report and view the pages to determine which ones you want to print. 
Then choose File, Print from the Menubar. In the Print Dialog Box enter the 
pages that you want to print and choose OK.
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QUICKSTART INSTRUCTIONS

Understanding Relationships
This program is a "RELATIONAL DATABASE". The relationships that are built 
into the program eliminate the need to enter information more than once.
Some of the built in relationships for example are: Every Puppy is related 
to a specific litter, Every Litter is related to a specific Dam and a 
specific Sire, Every Dog is related to a specific Breed. 
Some of the relationships are obvious and some are not. Most people just 
expect them to work! The relationship between each puppy and the litter they 
are related to is based on a hidden number assigned to the litter and 
inherited by each of the puppies entered in the litter record. 
On the other hand, the relationship between litter and the Sire and Dam is 
completely different. When you enter a Sire and a Dam in the "Litters and 
Puppies" Form, you are actually copying this information, as it is entered 
for the Dog, into a litter record with a different look to it and list boxes 
to pick from. The lists for the Dam and Sire on the "Litters and Puppies" 
form are a combination of the Dog's name + spacing + the dog's number as it 
is s entered in the dog's record. For this Mating/Litter to be displayed in 
each dog's mating records, the entry must match exactly. Each Dog's "Mating 
Records" form sorts through all of the litter records and only displays the 
mating records that match the Dog's name + the correct spacing + the Dog's 
numbers for each Dog. So if the registered name or numbers for the dog are 
changed after a mating has been entered then it is necessary to re-pick the 
Dog's name on the Litters and Puppies record(s) for the Dog whose name or 
numbers has been changed.

Quickstart Steps
THE MOST IMPORTANT THING in using this program is that you begin by entering 
your data in the correct order. This will save you time and work and allow 
you to get the most out of the program. There are some things you need to do 
before you begin entering the Dog records. Just follow the steps below and 
you'll be off to a good start.

IF YOU ARE NOT FAMILIAR WITH BASIC FEATURES (like adding and deleteing 
records) you should review the GENERAL HELP TOPICS before you begin.

Review the Basics
You will find Help for learning the basics of using the program in the 
General Help Topics in the program. There are also Help Buttons on most of 
the forms to provide specific information about using the Form you are on.

Quickstart Step 1
Add people to the program. Just choose "People" from the main menu.
Kennel Owner 
Detail

Add your kennel info. This will be displayed on various 
Form and Report Headings.

29



Breeder Rolodex Add a record for yourself and anyone else that you will 
be entering into the records for your dogs as owners, 
people you sell to or have purchased from. The people 
entered in this Rolodex will be available to choose from 
the lists on various forms. some forms require the person 
to be picked from this list and others allow you to type 
in a name and address or choose it from the list.

Misc. Rolodex This Rolodex can be used to record info for people such 
as vets, suppliers, family etc... that you want to keep 
contact information for but will not be entering on the 
records.

Show Handlers 
and Show Judges

If you will be entering show records you may add info 
here about the Handlers or Judges to be entered on the 
Show records.

Quickstart Step 2
Edit the Master lists. Just choose "Master Lists" from the main menu.
Breeds It is extremely important to get these entered correctly 

before you add your dogs. Each Breed you have in the list 
must be singular (ie:Pug, not Pugs) and spelled out 
correctly as the official name of the Breed (ie:Shetland 
Sheep Dog, not Sheltie). You will be able to add breeds 
at any time so you may delete the breeds you won't be 
using and just start with the ones you need.

Medical Entries 
List

This is where you add any items you will want available 
for quick entry on the medical records. You will be able 
to type in items that are not in this list but if you 
will enter an item often you should put it here to 
prevent retyping it over and over. You can always add to 
or make changes to this list later.

Custom Contract 
Terms

This is where you edit the actual contract terms that you 
will want available to insert onto the various contracts 
in the program. You can design a variety of contracts 
here for your needs. You can do this later but they must 
be designed here before they can be inserted into a 
contract. You can change the samples or delete them and 
add your own. As many as you need.

Quickstart Step 3
Add your Adult Dogs. Just Choose "Dogs" from the main menu.
The Samples There are sample records in the program. You may delete 

the samples at any time but we recommend that you leave 
them there for reference until you have added at least 
one dog.

Adding Dogs Use the New button on the form to open a blank/new record 
and add the information for the Dog.

Related Records 
and Reports

The "Dog Records" form has buttons on the left side to 
open other forms for entering records, printing your 
records and viewing or printing related reports. Note: 
Mating records for the Dogs are automatically displayed 
from the Matings entered in the "Litters and Puppies" 
form.
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Quickstart Step 4
Add Matings, Litters and Puppies. Just choose "Litters and Puppies" from the 
main menu.
Entering a 
Mating

On the Litters and Puppies form just fill in the 
information in the section that says "Enter the Mating 
Information Here". This will automatically add the mating 
record to the Dam's record and Sire's record. If you want 
to enter a mating between 2 different breeds or a mating 
where one dog is not entered in your dog records you will 
need to click on the button that says "Enter a Special 
Mating" and enter the record there.

Adding the 
Litter 
information

After the Mating info has been entered on a record in the 
"Litters and Puppies" form you can complete the Litter 
information for the record at any time. Just locate the 
record with the mating information and add the Litter 
information.

Adding Puppies 
for a Litter

After the Litter info has been entered on a record in the 
"Litters and Puppies" form  you can add puppies for the 
litter at any time. Just locate the record with the 
mating and litter information and add the basic puppy 
information at the botom of the form. Click on the arrow 
button above the puppy lines when you want to add sales 
information for the puppies you have entered.

Related Records 
and Reports

The "Litters and Puppies" form has buttons on the left 
side to open other forms for entering records, printing 
your records and viewing or printing related reports.

Quickstart Step 5
Learn to make a Backup. Nothing is worse than investing the time to enter 
your records and then loose it all if your computer dies. There is 
information in the General Help Topics and in the User Manual about how to 
make backups. If you need additional help in making your first backup you 
may call us to have someone walk you through it.

Quickstart Step 6
Have Fun and Explore the many features available in the program. Anytime you 
have questions and can't find the answers in the built in Help information 
feel free to contact us for assistance.
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PICTURES AND LOGOS

Pictures the Easy Way
Getting Pictures into your records.

The simple way to add a picture to a dogs record is:
1.) Get the picture into your computer by whatever means you have available. 
Such as a scanner, digital camera, or pictures developed on disk.
2.) Open the program that you normally use to view and edit the pictures 
when you put them into the computer. Open the picture you want to use. 
Select the entire picture or part of it, NOT the picture's filename, the 
actual picture and copy it to your invisible clip board. You may need to 
locate the tool that allows you to draw a square around the picture or a 
part of the picture.  If the program you are using doesn't have a selection 
tool try using the windows Paint program.
3.) Close or minimize the picture program.
4.) Open E-Z KENNEL PLUS. Open the Dog Records- Entry form and go to the 
record for the appropriate dog. Click on the Picture Button (camera) and 
click inside of the area where the picture is to be displayed. From the Edit 
menu choose Paste.
WHA  LA… You have the picture in the dog's record.

Note: Try to make the picture as square as possible and it will utilize the 
available space better. If it is not square it will be automatically resized 
and displayed  to best fit the area and will not be distorted but may not 
use the entire area.

Pictures in Other Ways
Using other graphics or logos.

If you do not have actual pictures of your dogs but would like to add class 
to your printouts you may want to use some good clipart or even design a 
custom logo to paste into the picture area for each dog. This would be 
displayed on the forms like pedigrees and contracts rather than leaving a 
blank area where the picture would be.

Basically you can paste in anything that you are able to copy to your 
clipboard.

Note: Try to make the picture as square as possible and it will utilize the 
available space better. If it is not square it will be automatically resized 
and displayed  to best fit the area and will not be distorted but may not 
use the entire area.
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MAKING BACKUPS

Files that contain your Data
There are 3 files in this program that contain information and settigs that 
you have entered. Those files are: 
1.) ezdata4.mdb  which contains the bulk of your kennel records.
2.) ezkenel3.mdb  which contains your mileage records, medical routines and 
setting you have changed such as print margins and datasheet formatting.
3.) usda.mdb  which contains records entered in the Misc rolodex that most 
people don't use.
These are the 3 files that you should always keep backed up. 
Backing up the entire C:\ezkenel3  folder is a good idea if you have room on 
your backup media.

Backup Hardware & Software
There are backup utilities by various companies available on the market or 
provided with your computer depending on the version of windows you are 
using and the hardware that is installed.

However you decide to do your backups just be sure you learn how and do it 
regularly !!! 

If you need help the first time you can contact us for assistance.  If you 
are using software and/or harware that we are not familiar with you may need 
to contact the vendor of the software or hardware for assistance.

Using Backup Utilities
Some backup utilities, such as Windows Backup use compression and create a 
backup file. They can be confusing sometimes because the only way to restore 
files from those utilities is to use the same utility to extract the data 
and restore it to a specific location. This can be a problem if the new or 
rebuilt computer is not capable of using the utility that created the 
backup. For example: If you used the Windows 98 Backup to make a backup of 
your data and then your PC crashed and you purchased a PC with Windows XP 
you would not be able to restore your data because a Windows 98 backup file 
is not compatible with the Windows XP Backup Utility. (Who knows why they 
did that???)

Making Backup Copies
It is generally safer and easier to  make copies of the files that contain 
your records on some form of removable media that will be usable in other 
computers.  
We recommend using media such as CDs, DVDs, USB Thumb Drives or USB portable 
Hard Drives.  
You may want to use the software that came with a device or simply use 
Windows Explorer to view or copy specific files and/or folders on your 
computer (using drag and drop) to the other media we suggested above.

PLEASE NOTE: IF YOU SEND A COPY OF THE SHORTCUT THAT OPENS A PROGRAM TO A 
DISK OR CD IT IS ONLY A SHORTCUT. A SHORTCUT DOES NOT CONTAIN ANY OF YOUR 
RECORDS, IT ONLY TELLS THE COMPUTER WHAT PROGAM TO OPEN.
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Testing your Backup
It is a good idea to test the method of backup you are using to ensure you 
are getting your records copied correctly. 
You will not be able to open the copies of your data files on the media to 
see what is there so it is a good idea to do a real test.
You can test your backup by following these steps.

1.)Make the backup copy of the data files in the manner of your choice.
2.)Open the E-Z KENNEL PLUS program, add a sample record and then close the 
Program.
3.) Restore the backup copy of the data file that did not contain the sample 
record.
4.)Open the program and see if the sample record you entered is gone. 

*If the sample record is gone that would mean that you had created and 
restored the backup file successfully. 

*If the sample record is still there you are NOT doing it right so go back 
to the drawing board or get some help.
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REPAIR AND COMPACT

Using the Repair and Compact Utility
You can only Repair and Compact one file at a time. You must complete all 
steps listed here for the file to be Repaired and compacted Properly. You 
will know you are done with a file because the utility will close 
automatically.

In this example we will be Repairing and Compacting the file "ezdata4.mdb" 
This is the file that contains most of your data.  You may also repair and 
Compact the "usda.mdb" which holds only the data you enter in the Misc. 
Rolodex form and the "ezkenel3.mdb" which contains the programming.

Steps to Repair and Compact a database
To Repair and Compact a database follow the steps below. If you do not 
follow the steps exactly and keep the same file name through all steps for 
repairing and compacting a file you could loose your records. If you feel 
more comfortable with help just call to have someone walk you through it.
Step 1 Make sure the E-Z KENNEL PLUS program is CLOSED.
Step 2 Open the Repair and Compact utility by choosing the 

shortcut that was installed in your menus along with the 
E-Z KENNEL program.

Step 3 When the program opens the Title bar says "Repair 
Database". Choose the ezdata4.mdb file in the list of 
files in the left pane of the window so that it is put in 
the box directly above the left pane of the window and 
just under the words File Name. Click OK.

Step 4 You will get a message saying the file has been 
successfully repaired. Click OK.

Step 5 Now the Title bar says "Database to compact from". Again, 
Choose the ezdata4.mdb file in the list of files in the 
left pane of the window so that it is put in the box 
directly above the left pane of the window and just under 
the words File Name. Click OK.

Step 6 Now the Title bar says "Database to compact into" and the 
filenames are a lighter shade than before.  Again, Choose 
the ezdata4.mdb file in the list of files in the left 
pane of the window so that it is put in the box directly 
above the left pane of the window and just under the 
words File Name. (Do not use the suggested filename db1…) 
Click OK.

Step 7 Now a message box will appear telling you the file 
already exists and asking if you want to replace it. You 
must Click Yes. This will replace the original file with 
the one that has been repaired and compacted. The Repair 
and Compact utility will automatically close when it is 
finished. If you would like to Repair and Compact another 
file you just open it again and follow the same steps for 
the next file.
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TECHNICAL SUPPORT

Contacting Chapman Pet Programs
We offer Free, Unlimited Technical support to our customers. That means you 
are never charged for support and you are not limited to the number of times 
that you can contact us for support.

Office Hours are 9:00AM to 3:00PM CST on Mon., Tues., Thurs. and sometimes 
on Fri. as of Feb. 2005. (Office Hours are subject to change).  For 
information about our current hours you may visit our website at 
www.ezkennel.com or call us.

Technical Support By Phone
Call(217)696-2551 

We are only available by phone during Office Hours and by Appointment. If 
you call after Office Hours you will receive a message about our current 
Office Hours and other support options. 
When calling for help with a problem be sure to be at your computer and 
ready to walk through the problem when you call.
If you need to speak to us by phone but are not able to call during our 
regular Office Hours you may contact us by fax or e-mail to schedule a phone 
appointment. We will do our best to arrange a time when you can call and 
someone can be in the office to help you.

Technical Support By Fax
Send Faxes to:(217)696-2802

We respond to faxes by fax back only. So be sure that you include a fax 
number that we can fax the response to.
You can send a fax at any time. We check for faxes even on days that the 
office is not opened if and when we are available. 
When sending a fax for help with a problem please be specific. We will need 
to know what program you are using, what form you need help with, any 
messages you received (word for word)etc...
Also please include your name and address so that we can locate your 
customer record to better assist you.
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Technical Support By E-mail
Send E-Mail to askme@ezkennel.com (subject to change).
 
We reply to e-mail by e-mail only. We check for e-mail even on days when the 
office is not opened if and when we are available. 
If you do not receive a response by the first business day following your 
request then we probably did not receive your e-mail. You may need to go to 
our website www.ezkennel.com to see if we have a new e-mail address as we 
have had to change it in the past due to overwhelming junk mail and may 
again at some point in the future.
When sending a fax for help with a problem please be specific. We will need 
to know what program you are using, what form you need help with, any 
messages you received (word for word)etc... 
Be sure that you enter a subject in the subject line of your e-mail or it 
may be automatically deleted.
If we receive attachments without an explanation in the message text they 
are also automatically deleted.
Also please include your name and address so that we can locate your 
customer record to better assist you.
When corresponding by e-mail about a problem it is also important that you 
keep all previous message text (related to the problem) included on all e-
mails until the problem is resolved so that we don't repeat ourselves.

Technical Support By Snail Mail
Send "Snail Mail" to us at the following address:
Chapman Pet Programs
1951 Hwy 61
Loraine, IL 62349

37



FORMS AND REPORTS

The Main Menu
The Main Menu of the Program is where you begin. From here you may view 
Legal Information, Quickstart Instructions and other menus which include 
General Help Topics and the various Forms and Reports available in the 
program.

E-Z KENNEL PLUS
Opens the Legal information contained earlier in this User's Manual. We have 
added this within the program for reference in case you can't find the 
User's Manual.

Quickstart Instructions
The Quickstart Instructions provided earlier in this Manual and also in the 
Program contain very useful information about getting started in the program 
the right way. If you do not read and follow the Quickstart instructions you 
will undoubtedly have problems. We don't expect people (especially Men...) 
to read the entire User's Manual before they begin but it would really be 
nice if everyone would at least read the Quickstart Instructions before they 
start using the program. 

We have included these instructions within the program and in this online 
User's Manual rather than in print for this version so they can not be lost 
or thrown away... You may print any of the Help Topics, Form Help Files or 
the User's Manual if you like.

Help & Network Setup
Opens the Help - Menu which displays the General Help Topics which are 
included earlier in this User's Manual. There are Help Topics to cover all 
basic features of the Program. If you are new to using this type of program 
or have questions about the basic features or use of Forms and Reports you 
should browse through these topics. 

The Network setup is available from the Help Menu. This is where you set the 
location of the data file when using the software on a network. The location 
of the data files should only be modified by the Network administrator or 
someone who knows the actual mapped drive letter of the server. The location 
must be entered as in the example. You must change only the single drive 
letter. You can not use drive names or descriptions that have been assigned 
to represent the server.

We have included these Help Topics within the program and in this online 
User's Manual rather than in print for this version so they can not be lost 
or thrown away... You may print any of the Help Topics, Form Help Files or 
the User's Manual if you like.
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Master Lists
Opens the Master Lists - Menu that displays buttons to open the forms 
described in this section which are used to create the lists of information 
that will be used throughout the program.

Breeds - Entry
This is where you enter the breeds you will need to use for your records.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View.
Normal Sort 
Order

These records are sorted alphabetically by Breed each 
time the form is opened regardless of the order they were 
entered. If they don't seem to come up in alphabetical 
order when you open the form you should check for blank 
spaces at the beginning of the breed.

Breeds It is important to get it right the first time! Each 
Breed must be entered in singular form, ie Pug, not Pugs. 
Use the official breed spelling rather than abreviations 
and make sure you spell it correctly. If you must change 
the spelling later you will then need to correct the 
spelling on all dog and litter records to insure that 
your data is displayed correctly on various Forms and 
Reports. Even if you change a dash or a space the program 
sees it as a different breed. You may delete the breeds 
you don't need. You can always add breeds later as you 
need them.

Wholesale and 
Retail Prices

The prices you enter here are for your reference only. 
These prices are not used on other records.

Medical Entries List - Entry
This is where you create a list of items or procedues you will want 
available for quick entry on Medical records for your Dogs or Litters. You 
will also be able to type in things that are not in this list so just enter 
things here that will be used repeatedly.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View. There 

is not really a need to print this list as it is just a 
list of items you will be choosing on other records.

Normal Sort 
Order

These records are sorted alphabetically by Type each time 
the form is opened regardless of the order they were 
entered.

Changing Lot#s 
and Exp. Dates

When you purchase new vaccine you can just update the 
Exp. and Lot# for the vaccine here. These fields can be 
left blank or used for other information where a Lot# or 
Exp. Date do not apply.
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Custom Contract Terms - Entry
This is where you build your custom reusable terms and conditions to be 
inserted on Sales, Stud Service and Lease contracts and on Customer Pet 
Records. All Contract Terms must be designed here first to be available for 
specific contracts. To insert the terms on an actual Contract you just use 
the listbox field in the contract header to choose which set of terms you 
want to be inserted on the contract.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View. 

Printing is not really necessary as you will most likely 
retain hard copies of the actual contracts where the 
terms are used.

Normal Sort 
Order

These records are sorted alphabetically by Contract ID 
each time the form is opened regardless of the order they 
were entered.

Contract ID The Contract ID can contain up to 10 characters and must 
be unique.

Description The Contract Description can contain up to 50 Characters 
and should be a very breif description of the Contract 
Terms.

Contract Text The Contract Text is the actual terms and conditions to 
be inserted on the desired Sales, Stud Service or Lease 
Contracts or Customer Pet Record. The Contract Text will 
hold up to 64,000 characters. The Various Contracts will 
expand when printed to show all of the Contract Text.

How Many? You may design as many sets of terms and conditions as 
you like. You may delete the samples or just change them 
and add others as needed.

People
Opens the People - Menu that displays buttons to open the forms and reports 
described in this section which are used to store and print information 
about People.

Kennel Owner Detail - Edit
This is where you enter the Owner information to be displayed in headings on 
various Form and Report Printouts.
Data Entry Edit the record that is there.
Views Allowed Form Only
Printing No need to print this form. This info will be displayed 

on other Forms and Reports for Printing.
Only 1 Record There is only one record available here. If you have 

multiple owners you will have to combine the names on the 
Record.

How will it 
look?

To see how the info will be displayed you can check out 
some of the Forms that display this information such as 
Customer Pet Records, Litter Pedigrees, Invoices, On Hand 
and Sales Reports etc...
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Breeder Rolodex - Entry
This is where you add yourself and other people you will be entering on 
various records throughout the program. These people will be available in 
the lists for Quick entry.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View. You may 

prefer to print the available Address Book Report or 
Mailing Labels by selecting the appropriate button at the 
top of the form. There is an envelope button to open the 
Mailing Labels and a Notebook button to open the Address 
Book.

Normal Sort 
Order

These records are sorted alphabetically by Last Name each 
time the form is opened regardless of the order they were 
entered.

Changes to 
these Records

If you make changes to a record you will need to update 
the appropriate Dog and Litter Records to include the 
changes. To update those records you simply locate the 
records you need to update and  re-select the person from 
the list so the changes are displayed on the record.

APRI Cust.# This is the Customer ID Number for America's Pet 
Registry, Inc. It is displayed on the Litter Apps for 
APRI. If you do not use APRI then you may leave this 
blank or use this field for something else.

Breeder Mailing Labels - Print Only
This form is designed for printing mailing labels for people entered in the 
Breeder Rolodex with the "Add to Mailing Labels" checkbox selected.
Printing Use the "More" button in the Print Setup to adjust the 

margins, columns and spacing. You may print the labels on 
a variety of label layouts simply by adjusting the Print 
settings. Any labels that are 1"X2.6" or larger will 
work. Always check the Print Preview and print to plain 
paper to make sure you have the settings correct before 
printing to actual labels.

Breeder Address Book - Print Only
This report is designed for printing an address book including people 
entered in the Breeder Rolodex with the "Add to Address Book" checkbox 
selected.

Misc. Rolodex - Entry
This is where you add people, businesses, suppliers etc. that you will not 
be entering on records but wish to keep track of. These people will not be 
available in the lists for Quick entry.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View. You may 

want to print the Mailing Labels by selecting the 
envelope button at the top of the form.
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Normal Sort 
Order

These records are sorted alphabetically by Last Name each 
time the form is opened regardless of the order they were 
entered.

Code This field is for entering codes to use for filtering the 
mailing labels. For example if you enter the code F for 
all family members then you can filter the mailing labels 
to print labels just for all family members.

Add to Mail List When you open the mailing labels it includes only people 
with a check in this box.

Within Pickup 
Area

You may use a filter on the mailing labels to include 
only people with a check in this box.

Misc. Mailing Labels - Print Only
This form is designed for printing mailing labels for people entered in the 
Misc. Rolodex with the "Add to Mailing Labels" checkbox selected or by the 
selected filter.
Printing Use the "More" button in the Print Setup to adjust the 

margins, columns and spacing. You may print the labels on 
a variety of label layouts simply by adjusting the Print 
settings. Any labels that are 5/16"X3.5" or larger will 
work.Always check the Print Preview and print to plain 
paper to make sure you have the settings correct before 
printing to actual labels.

Filters You may filter the mailing labels by On Mailing List, In 
Pickup Area, or by a specified Code.

Show Handlers - Entry, Print
This is where you enter People who are Show Handlers of your dogs to be 
available on list for the show records.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View.
Normal Sort 
Order

These records are sorted alphabetically by Last Name each 
time the form is opened regardless of the order they were 
entered.

Show Judges - Entry, Print
This is where you enter People who are Show Judges to be available on list 
for the show records.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View.
Normal Sort 
Order

These records are sorted alphabetically by Last Name each 
time the form is opened regardless of the order they were 
entered.
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Kennel Stuff
Opens the Kennel Stuff - Menu that displays buttons to open various forms 
and reports described in this section which are used to store and print 
General Kennel Records. You may also open some of the Adult Dog Reports and 
Litter and Puppy Reports from here.

Income and Expense Records - Entry
This is where you enter Income and Expense records for your business. There 
is no need to enter the Puppy sales or the Adult Dog purchase and sales 
information because there are seperate automated financial reports for those.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View. Most 

likely you will want to use the Report for printing these 
records.

Normal Sort 
Order

These records are sorted by date each time the form is 
opened regardless of the order they were entered.

Adding 
Categories

The categories are based on what has been entered in the 
records. If you delete the sample records there will be 
no categories to begin with. To add a category you just 
type it in the category field. Once it has been entered 
on a record it is added to the list for future records so 
that you can choose it again. You can add as many 
categories as you like. some typical categories you may 
want to add are: Dog Food, Vet Fees, Vaccines and 
Medications, Building Materials, Travel, Cleaning 
Supplies... You may also want to add a specific dog as a 
category if it requires a large amount of Medical care. 
You may also decide to break down some of the Medical or 
Vet costs into seperate categories for things like C-
Sections, Ear Crops or Naris. Just build your categories 
according to how you like to see your income and expenses 
broken down.

Viewing or 
Printing the 
Report

When you click on the "Open Report" button you will be 
asked to enter a beginning date and then an ending date. 
When the report opens it will contain all entries for 
that date range. The entries are grouped and totaled by 
category and there is a Grand Total for all entries. You 
may view or print a report for any date range at any time.

Mileage Record - Entry, Print
This is where you keep track of tax deductible miles for your kennel 
business.
Data Entry Full
Views Allowed Form or Datasheet. The Datasheet View will not show you 

the Total Miles.
Printing Records may be printed in Form or Datasheet View. The 

Datasheet view will not print the Total Miles.
Normal Sort 
Order

The records are automatically sorted by date each time 
the form is opened regardless of the order they were 
entered.
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Trip Miles and 
Total Miles

The Trip Miles and Total Miles are calculated for you 
based on the odometer readings you enter. You CAN NOT 
just enter the trip miles.

Kennel Memos - Entry, Print
This is where you enter memos pertaining to the Kennel in General.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View.
Normal Sort 
Order

These records are sorted by date each time the form is 
opened regardless of the order they were entered.

Kennel TO-DOs - Entry, Print
This is where you schedule things to do pertaining to the Kennel in General. 
These things will show up on the Misc. To Do report and also on the Things 
To Do Today report.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View or by 

way of the To Do Reports.
Normal Sort 
Order

These records are sorted by date each time the form is 
opened regardless of the order they were entered.

The Kennel 
(Misc.) To Do 
Report

This report shows all items entered in this form that are 
marked To Do. The past due items are not removed from the 
report until marked Done or Deleted.

Things To Do Today - Report
This Report opens automatically when you open the program. It can also be 
opened at any time from the "Kennel Stuff" Menu. This report shows you the 
items you have scheduled to be done today in black and also includes any 
past due items in red. The Report includes items entered in the Kennel To 
Dos, the Adult Dog To Dos, and the Litter To Dos.

Dogs
Opens the Dog Records - Entry form (described below) which also contains 
buttons to open the other forms and reports described in this section which 
are used to store and print all of your Adult Dog Records.

Dog Records - Entry (Form)
This is where you add or edit your adult dog records. 
This form has buttons to open related forms for entering additional 
information and various forms or reports designed for printing your records.
Data Entry Full
Views Allowed Form or Datasheet
Printing Use the Datasheet or the related Forms and Reports to 

print these records.
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Normal Sort 
Order

These records are sorted alphabetically by Breed, Sex and 
Name each time the form is opened regardless of the order 
they were entered.

Filters On Hand, By Status, By Breed, By Sire, By Dam
The "Go To" 
Field at the 
top of the form.

Is used to select the record you want to see or edit.  
This list is created from the records that are available 
when the form is opened. The list shows the Call Name, 
Dog ID#, Name and Registration #s but is actually sorted 
by Breed, Sex and then the Name. You can not edit the 
list for this field manually but when you Add records, 
Delete records or Change records this list will be 
automatically updated to show the changes you have made 
the next time you open the form.

Duplicate Values You can not use the same ID # or Registration # for 2 
dogs even if they are different breeds. If you get a 
message that the record can not be saved because of a 
duplicate value it is because one of those numbers has 
already been used for another dog.

Changing Names 
or Registration 
#s

When you change the Name or either Reg.# or add a Reg.# 
for a dog with mating records already entered, you will 
need to update the Dog's Name and Reg.#s on all mating 
records that have been entered for that dog. If you don't 
update the mating records with the changes you made then 
those mating/litter records will still be in the program 
but they will no longer match the dog's record so they 
will no longer be linked to the dog. This will affect the 
dog's mating and production records, the heats due and 
dogs due to whelp reports etc. To update the mating 
records just open the Litter and Puppy records form and 
scroll through the records to locate the ones that need 
updated, backspace the old name & number that is there 
out of the field and re-pick the dog from the list with 
the changes.  Also if you have entered any Stud Service 
Contracts for the dog you will need to update the name 
and number on those records.

To locate a dog 
quickly

The "Go To" list at the top of the form is designed to 
locate a dog's record quickly but if you would like to 
find a dog based on a particular field it may be faster 
for you to use the "Find" feature (binoculars button) on 
the Toolbar. For example:To use the "Find" feature to 
locate a dog by his ID# you simply put your cursor in the 
Dog ID# field of any dog's record then click on the 
binoculars, enter the Dog ID# you are looking for in the 
"Find What" field and click "Find First" or "Find Next" 
to go directly to the record you are looking for. See the 
General Help Topics for more info about using the "Find" 
feature.

Opening the 
related Forms 
and Reports

There are buttons on the left edge of this form that open 
related Forms and Reports. When you open the related 
forms or reports most of them will display only the 
record for the dog you are on in this form. Many of them 
have a "Show All Records" button that allows you to view 
the records for other dogs without having to close the 
related form to come back to this form to locate another 
dog and then reopen the related form...

The Breed List The list of Breeds you have to choose from is made up of 
the Breeds you entered in the Breeds Form that can be 
opened from the Master Lists Menu.
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People Lists The list in the fields where you enter various people on 
this form include all people that were entered in the 
Breeder Rolodex that can be opened from the People Menu.

Dog Medical Records - Entry, Print
This is where you add the Medical Records for the Dogs. They can be 
scheduled ahead of time so they appear on the "To Do" report or entered as 
they are completed.
Data Entry Full
Views Allowed Form View Only
Printing May be printed in Form View. Includes the identification 

information for the Dog when printed.
Normal Sort 
Order

These Records are sorted by date each time the form is 
opened regardless of the order they were entered.

Filters When you first open this form it will show only the 
record for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Medical Records for all of your dogs just click on the 
"Show All" button. After you click on the "Show All" 
button there will be a "Go To" list displayed at the top 
of the form where you can select a specific Dog to view 
his Medical Record. There will also be Identification 
fields added at the top so you will not be confused about 
which dog's record you are on.

Status field Must be Done or To Do. All To Do items will be displayed 
on the Adult Dogs To Do Report. Current and past Due To 
Do items will also be displayed on the Things To Do Today 
Report.

Administered 
field

You may select entries from the list or type whatever you 
want in this field. The list shows items entered in the 
Medical Entries List Form which can be opened from the 
Master Lists Menu.

Adult Dogs TO-DO Report - Print Only
This report includes all Adult Dog Medical Record entries with a To Do 
Status.

Dog Records, Landscape or Portrait - Print Only
This form is designed just for printing the permanent records for your dogs. 

The records can not be edited in this form. Each record contains the 
information that was entered for the dog in the Dog Records - Entry form. 
There is also info on the heading from the Kennel Owner Detail form.
Filters When you first open this form it will show only the 

record for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Records for all of your dogs just click on the "Show All" 
button. If you want to see just the records for all of 
the dogs that are On Hand just click on the "On Hand" 
button.
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Pictures - Edit, Print
This is where you add the Dog's Picture.
Data Entry Partial, you may only add or delete the picture. You may 

only add one picture for each dog. The other information 
displayed is from the information that was entered for 
the dog in the Dog Records - Entry form.

Views Allowed Form View Only
Printing This form may be printed in Form View or you may want to 

print other records for the Dog that display the picture 
or the Photo Album which contains all of the pictures you 
have entered for your dogs in the program.

Filters When you first open this form it will contain only the 
picture for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Records for all of your dogs just click on the "Show All" 
button.

Adding a Picture The easiest way to add pictures is to open the picture 
using whatever program you usually use to view your 
pictures. Use the selection tool to draw a square around 
the entire picture or just the desired area of the 
picture you want to use. Copy the selected area to the 
clipboard and then close that program and open the E-Z 
KENNEL PLUS program and open this form for the dog. Just 
click in the picture area and then choose Edit, Paste 
from the Menubar to insert the picture. See the General 
Help Topics for more information about putting pictures 
in the program.

Size and Shape The picture will be resized to best fit the picture area 
of the form. It will not be distorted but if it is not 
relatively square it may not use the entire space allowed 
for the picture.

Picture Quality The quality of the printed picture will depend on the 
quality of the original photo. Higher resolution pictures 
are better quality but also consume more space and will 
slow down the use of the program if you are adding a 
large number of pictures or using a computer that does 
not have the best graphics hardware.

Dog Pen Cards - Print Only
This form was designed to print 3x5 or 4x6 index cards to place on your dog 
pens. 

These records can not be edited in this form. Each record contains the 
information that was entered for the dog in the Dog Records - Entry form.
Printing Use the "More" button in the Print Setup to adjust the 

margins, columns and spacing. You may print the cards on 
a variety of card or paper sizes simply by adjusting the 
Print settings. The printed area of the pen card is 3" x 
5". Some printers must allow 1/2" space on all sides so 
you may need to use 4" X 6" cards or larger. Always check 
the Print Preview and print to plain paper to make sure 
you have the settings correct before printing to actual 
cards.
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Filters When you first open this form it will contain only the 
card for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Records for all of your dogs just click on the "Show All" 
button. If you want to see just the records for all of 
the dogs that are On Hand just click on the "On Hand" 
button.

Tip If your printer does not like printing on the cards or 
you have trouble getting the margins adjusted correctly 
you can purchase 8.5"X11" cardstock to print multiple 
records on and cut them to the size you want.

Tip If you would like to see more or different info on your 
dog pens you may want to purchase shop ticket holders 
which come in a variety of sizes that will hold even full 
size pages. They are made of tough transparent plastic 
and some have ziplock closures to keep out moisture. You 
can purchase them at most office supply stores and keep 
any printouts or records you like on your pens.

Folder Labels - Print Only
This form was designed to print folder labels for your Hardcopy (Papertrail) 
Records for each dog. 

The records can not be edited in this form. Each record contains the 
information that was entered for the dog in the Dog Records - Entry form.
Printing Use the "More" button in the Print Setup to adjust the 

margins, columns and spacing. You may print the labels on 
a variety of label layouts simply by adjusting the Print 
settings. Any labels that are 3/4" X 3.5" or larger will 
work. Always check the Print Preview and print to plain 
paper to make sure you have the settings correct before 
printing to actual labels.

Filters When you first open this form it will contain only the 
label for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Records for all of your dogs just click on the "Show All" 
button. If you want to see just the records for all of 
the dogs that are On Hand just click on the "On Hand" 
button.

Mating Records - Print Only
This form was designed to print the mating record for each dog. 

The records can not be edited in this form. Each record contains the 
information that was entered on the Litters and Puppies - Entry Form.
Filters When you first open this form it will contain only the 

mating record for the dog whose record you were on in the 
Dog Records - Entry form. If you want to browse through 
the Records for all of your dams just click on the "For 
All Dams" button. If you want to see the Records for all 
of the sires just click on the "For All Sires" button.
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Missing Records 
for a dog..

If you have entered matings for a dog and they are not 
showing up here then the dog's name and numbers on the 
mating record don't match this dog's name and numbers 
exactly. You will need to locate the Litter record and 
reselect this dog's name to correct it so the record will 
be linked to this dog again.

Dog Pedigrees - Print Only
The Pedigree forms were designed for Printing Only. 

The records can not be edited here. Each record contains information that 
was entered on the Dog Records - Entry. You must have information entered in 
the Continue Sire Pedigree and the Continue Dam Pedigree forms.  If this 
pedigree does not display the correct information you will need to go back 
and correct those records. The Owner Information that is displayed in the 
top left corner is what you have entered in the Kennel Owner Detail form 
which you open from the People Menu. If it does not display here as you like 
you will need to open and edit that record.
Filters When you first open this form it will contain only the 

Pedigree for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Records for all of your dogs just click on the "Show All" 
button.

Custom Borders 
and Watermarks

We have designed 3, 4 & 5 Generation Pedigree choices 
that you may print with or without a border. The reason 
we gave you the option of printing them without the 
border is so that you could design your own if you like. 
To use custom borders or watermarks you may purchase or 
design and print the borders and backgrounds of your 
choice and then simply print these pedigrees without the 
border onto your custom designed sheets.

E-mailing a 
Pedigree

This program does not have the ability to e-mail directly 
from the program but there is a way to do it. We use a 
utility called ScreenPrint which is a screen capture 
utility that runs in the background and allows you to 
capture anything on your screen at any time. Once you 
capture something you can e-mail it, save it, Print it, 
Edit it like a picture or whatever you want to do with 
it. You can download ScreenPrint from 
www.softwarelabs.com or choose from a variety of other 
screen capture utilities on the market.

Saving Changes 
to the Form

If you change the print settings for the form you will be 
asked if you want to save the change when you close the 
form. Sometimes if you choose yes you will get an error 
stating "Cannot Destroy Active Form Instance" If you get 
that error you can use the X button on the top right 
corner of the form to close it instead of the arrow 
(close) button to close the form and you won't get an 
error... We don't know why it does that but it sometimes 
does...

Show Records - Entry, Print
This is where you add show records for your dogs.
Data Entry Full
Views Allowed Form or Datasheet View
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Printing Records may be printed in Form or Datasheet View.
Normal sort 
Order

These records are sorted by date each time the form is 
opened regardless of the order they were entered.

Filters When you first open this form it will contain only the 
records for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Records for all of your dogs just click on the "Show All" 
button. If you want to add or edit Handlers, Judges or 
Location information you can open those records using the 
buttons on the top of the form.

Show Names and 
Classes

These fields have self building lists, that means that 
the list of available entries contains previous entries 
so that anything you have entered may be reused.

Handlers and 
Judges

The lists of available entries for these comes from the 
entries in the Show Handlers and Show Judges forms that 
can be opened using the buttons on the top of the form or 
from the People - Menu.

Locations The lists of available entries for these comes from the 
entries in the Show Locations  form that can be opened 
using the button on the top of the form.

Show Locations - Entry, Print
This is where you enter information about the Locations where shows are to 
be held.
Data Entry Full
Views Allowed Form or Datasheet
Printing Records may be printed in Form or Datasheet View.
Normal Sort 
Order

These records are not sorted. They stay in the order they 
are entered.

Sales Contract - Edit, Print
This is where you add or edit the sales info and add the desired Contract 
terms for the Sale of a Dog.
Data Entry Partial, You will only be able to edit a few fields on 

this contract. The rest of the information comes from the 
record entered on the Dog Records - Entry form and the 
Kennel Owner Detail form.

Views Allowed Form Only
Printing Records may be printed in Form View only.
Normal Sort 
Order

These Records are sorted by Breed, Sex and Name each time 
the form is opened to show all records regardless of the 
order they were entered.

Filters When you first open this form it will contain only the 
record for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Records for all of your dogs just click on the "Show All" 
button.

One for each Dog There is automatically one Sales Contract record added 
for each dog in the program.
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Adding the 
Guarantee

To insert the Contract terms you want to show on the 
contract you just select the Contract Terms ID in the 
list field at the top of the form.

Additional Terms This is where you would add any variations to the 
reusable Contract Terms that you have inserted.

Hard Copies Be sure to print 2 copies of the contract. Both should be 
signed, one for the purchaser and one for you.

Lease Contract - Edit, Print
This is where you enter a lease contract for a dog.
Data Entry Partial, You will only be able to edit a few fields on 

this contract. The rest of the information comes from the 
record entered on the Dog Records - Entry form.

Views Allowed Form Only
Printing May be printed in Form View only
Normal Sort 
Order

These Records are sorted by Date with the most recent 
ones first each time the form is opened to show all 
records regardless of the order they were entered.

Filters When you first open this form it will contain only the 
records for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Records for all of your dogs just click on the "Show All" 
button.

One for each Dog There is automatically one Lease Contract record added 
for each dog in the program.

Adding the 
Guarantee

To insert the Contract terms you want to show on the 
contract you just select the Contract Terms ID in the 
list field at the top of the form.

Additional Terms This is where you would add any variations to the 
reusable Contract Terms that you have inserted.

Hard Copies Be sure to print 2 copies of the contract. Both should be 
signed, one for the leasee and one for you.

Stud Service Contract - Entry, Print

Data Entry Full
Views Allowed Form Only
Printing May be printed in Form View only.
Normal Sort 
Order

These records are sorted by date each time the form is 
opened regardless of the order they are entered.

Filters When you first open this form it will contain only the 
records for the dog whose record you were on in the Dog 
Records - Entry form. If you want to browse through the 
Records for all of your dogs just click on the "Show All" 
button.

Adding the 
Guarantee

To insert the Contract terms you want to show on the 
contract you just select the Contract Terms ID in the 
list field at the top of the form.

Additional Terms This is where you would add any variations to the 
reusable Contract Terms that you have inserted.
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Hard Copies Be sure to print 2 copies of the contract. Both should be 
signed, one for the owner of each dog.

Dogs On Hand Report - Print Only
This is the report you use in place of the Dogs on Hand form required by 
USDA if you are USDA licensed. Everyone is supposed to submit copies of all 
computer forms they are using to the main office for individual approval. 
Just be sure that you send this report with your data entered. Last I heard, 
they don't approve blank forms. Also the inspectors will vary in what they 
want the form to contain. Some inspectors want to see the form including 
only the dogs currently On Hand. Other inspectors want to see all dog 
records with the dispersal information on the form. You can print this 
report either way so just ask your inspector how he would like to see it.
Data Entry None, This is for printing only. These records are from 

the information entered in the Dog Records - Entry form. 
The printed form also includes info in the heading from 
the Kennel Owner Detail form.

Views Allowed Form or Datasheet View
Printing Should be printed in Form View if submitting to USDA for 

Approval.
Normal Sort 
Order

These records are sorted by Breed, Sex and Name each time 
the form is opened regardless of the order they are 
entered.

Filters When you first open this Report it will contain only the 
records for the Dog's with the status of "On Hand". If 
you need to see all dog records just choose Records, Show 
All Records from the Menubar.

Dog Purchase and Sales Report - Print Only
This Report will ask you for a beginning date and an ending date when you 
open it. Once it opens it will show you all Purchases and Sales of Adult 
Dogs that occurred during that time frame with seperate totals and a 
Balance. The report includes a section which lists all dogs that died during 
the time frame as well.
Note You must enter the date purchased, purchase price, date 

of sale and sale price or the date died (where 
appropriate) and make sure the status field is correct 
for all dogs in the Dog Records - Entry form for this 
report to be accurate. The report also includes info from 
the Kennel Owner Detail form.

Heats Due Reports by Due Date or Breed - Print Only
There are 2 Heats Due Reports available. One is by Due Date and the other 
one is by Breed. These Reports include all dams with at least one 
Mating/Litter entered in the program.
How the next 
Heat is 
Calculated

The next Heat Due for each dog is calculated by adding 6 
months to the last date mated in the Mating/Litter 
records.

Skipped Heats If you have skipped a dog's heat and want to keep this 
report accurate you need to enter a Special Mating for 
the Dog but rather than enter the sire's name you just 
add something like "Skipped this Heat" in the Sire field. 
The record will show up on the dog's mating record and 
the Next Heat Due will be accurate in this report.

52



Missing Dogs on 
this Report...

If you have entered matings for a dog and they are not 
showing up on this report then this dog's name and 
numbers on the mating record don't match this dog's name 
and numbers exactly. You will need to locate the Litter 
record and reselect this dog's name to correct it so the 
record will be linked to this dog again.

Wrong date 
showing..

If it looks like a dog's next heat due is not being 
calculated from the last mating or heat entered you need 
to check the mating dates, you may have accidentally 
entered the last one as 1905 if you have not entered the 
4 digit year or used the Y2K fix as suggested.

Dogs Due to Whelp Report - Print Only
This Form shows you a list of Dogs that are Due to Whelp
Data Entry None, the records include dogs with a mating entered in 

the Litters and Puppies - Entry form but where no Whelp 
date has been entered.  If a Dog becomes over 30 days 
past Due she is automatically taken off of this report.

Views Allowed Form or Datasheet View
Printing Records may be printed in Form or Datasheet View.
Normal Sort 
Order

These records are sorted by Due Date each time the form 
is opened regardless of the order they were entered.

Dam or Sire Production Records - Print Only
The Dam and Sire production Records are based on the information that has 
been entered in the Litters and Puppies - Entry form. These records show you 
each Mating/Litter, the # of puppies whelped and weaned, the # of puppies 
rated as A, B and C quality and the Sire of each litter. These reports are 
very valuable for determining what sire you want to mate a dam to for top 
quality pups, what dams are producing the best quality and which ones are 
good mothers. This knowledge plays a vital role in having a productive 
kennel and raising top quality puppies.
Data Entry None, the records include dogs and their related records 

that are entered in the Litters and Puppies - Entry form.
Views Allowed Form Only
Printing Records may be printed in Form View only.
Normal Sort 
Order

These records are sorted by Breed each time the form is 
opened regardless of the order they were entered.

Missing Records 
for a dog...

If you have entered matings for a dog and they are not 
showing up on this report then this dog's name and 
numbers on the mating record don't match this dog's name 
and numbers exactly. You will need to locate the Litter 
record and reselect this dog's name to correct it so the 
record will be linked to this dog again.

Photo Album - Print Only
This report includes any dog's who you have entered pictures for. If you 
have a lot of pictures in the program it may take some time for this Report 
to open and print. The Report will display up to 6 records per page In order 
by Breed, Sex and Name.
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Continue Sire or Dam Pedigrees - Edit
This is where you enter most of the Pedigree information for a Dog. You must 
add records to continue both the Sire and the Dam pedigrees in order for all 
of the complete printable Pedigrees in the program to display properly.
Data Entry Full
Views Allowed Form Only
Printing Records may be printed in Form View but you will most 

likely want to print the full pedigrees rather than these 
sections.

Who goes here? Remember, you are not adding your Dog or it's Dam and 
Sire in this form as those dogs have already been 
entered. You are starting here with your Dog's 
Grandparents (the parents of your Dog's Sire or the 
parents of your Dog's Dam depending on which button you 
chose to open this form).

Where to start? When you open this form your cursor will be in the first 
line for the Sire. The Sire is always above and the Dam 
below the dog in the previous generation. There are 2 
lines for each dog in the first three generations shown 
here and only 1 line for each dog in the 4th generation. 
Normally people use the first line for the name and 
number of a dog and the second line for color and other 
info they want to enter. You can enter it however you 
like. When you use the Tab or Enter key on your keyboard 
you will move from the top to the bottom of the first 
generation and then from the top to the bottom of the 
second generation and so on. If you are not sure you are 
entering it the way you should you can enter a little and 
then go open the full pedigree for the Dog and see how it 
looks.

View the Samples If you have not deleted our sample dogs you can look at 
these records for them and the way this works will be 
obvious.

Copying this 
record to 
another Dog

We have added special Copy and Paste buttons to these 
forms that will copy and paste the entire section from 
one dog to another. When you are in a completed record 
(section) you use the copy button on the form to copy the 
entire record. Then you move to the blank record 
(section) where you want to insert the record and use the 
paste button to paste the entire record there.

Note You only copy and paste these records to other dogs with 
either the same sire or the same dam or both. The 
Pedigree would NOT be acurate if you pasted a record from 
one generation dog to another, like from one dog's record 
to it's offspring.

Litters and Puppies
Opens the Litters and Puppies - Entry form (described below) which also 
contains buttons to open the other forms and reports described in this 
section which are used to store and print all of your Mating, Litter and 
Puppy Records.
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Litters and Puppies - Entry
This is where you add and edit all Mating, Litter and Puppy records.
This form has buttons to open related forms for entering additional 
information and various forms and reports designed for viewing and printing 
your records.
Data Entry Full
Views Allowed Form or Datasheet View
Printing Use the Datasheet or the related forms and reports to 

print these records.
Normal Sort 
Order

These Records are sorted by Date Bred in Descending order 
(last bred is shown first) each time the form is opened 
regardless of the order they were entered.

Filters By Breed, By Sire, By Dam or View only records that are 
not marked as completed.

The "Go To" 
field at the 
top of the form

Is used to select the record you want to see or edit. 
This list is created from the records that are available 
when the form is opened. The list displays Date Bred, 
Date Whelped (if entered), and the Dam. The entries are 
in order by Date Bred, Descending. You can not edit the 
list for this field manually but when you Add records, 
Delete records or Change records this list will be 
automatically updated to show the changes you have made 
the next time you open the form.

Adding the 
Mating Info

Just complete the section that says "Enter the Mating 
Information Here" Pick the Breed, Dam, Sire, Owners and 
the person who handled the mating from the lists. The 
list of Breeds includes all Breeds you entered in the 
Breeds Form on the Master Lists - Menu. The list of Dams 
includes all Dams of the Breed you selected with the 
Status "On Hand", The list of Sires includes all Sires of 
the Breed you selected with the Status "On Hand",  The 
People in all lists include the people you have entered 
in the Breeder Rolodex on the People - Menu.

The dog I need 
to enter is not 
in the list.

If the dog is not in the list you will need to check the 
dogs record in the Dog Records - Entry form to make sure 
the Breed is correct (repick from the list to make sure), 
the dog's status is "On Hand" and the dog's sex is M or F.

Enter a Special 
Mating

If you would like to enter a mating to a dog that is not 
in your records, a mating between 2 different breeds or 
enter a skipped heat so that the Next Heat due is 
correctly calculated then you will need to use the 
Special Matings form. In the Special Matings form the 
lists for the dam and sire show all dogs in the program. 
You will be allowed to pick dogs from the list or type in 
the names for dog's not in the program or just type in 
text such as "Skipped this Heat". The record will still 
be displayed on the Mating records of any dog who was 
chosen from the dam or sire lists even if they were not 
the same breed and there will be a litter record added to 
the Litters and Puppies form that you will be able to 
complete as usual.
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Adding the 
Litter Info

Just complete the section that says "Enter the Litter 
Information Here" as you have the information available. 
When you enter the Registration Numbers you only enter 
the part of the number that is the same for all puppies. 
The last digits of the registration numbers that are 
different for each Puppy should be entered in the Puppy 
information under Reg.1 ID or Reg.2 ID. (See the Sample 
records if you have not deleted them)

Entering the 
Puppies for the 
Litter

You add the basic information for each puppy in the 
litter at the bottom of the screen where it says "Enter 
the Puppies Here". To add the sales information for the 
puppies you open the Puppies form.

To Locate a 
Litter Quickly

The "Go To" list at the top of the form is designed to 
locate a record quickly but if you would like to find a 
record based on a particular field it may be faster for 
you to use the "Find" feature (binoculars button) on the 
Toolbar. For example:To use the "Find" feature to locate 
a record by the Registration Number you simply put your 
cursor in the Registration Number field on any record 
then click on the binoculars, enter the Registration 
Number you are looking for in the "Find What" field and 
click "Find First" or "Find Next" to go directly to the 
record you are looking for. See the General Help Topics 
for more info about using the "Find" feature.

To Locate a 
Puppy Quickly

If you search for a puppy on this form you will only be 
able to find puppies in this litter. To search for a 
puppy when you don't know what litter it is from you need 
to open the Puppies form and select the "Show All 
Records" Button and then do the search there.

Opening the 
Related Forms 
and Reports

There are buttons on the left edge of this form that open 
related Forms and Reports. When you open the related 
forms or reports most of them will display only the 
record for the litter you are on in this form. Some of 
them have a "Show All Records" button that allows you to 
view the records for other Litters without having to 
close the related form to come back to this form to 
locate another Litter and then reopen the related form...

Special Matings - Entry
This is where you enter Mating Records that are somewhat out of the 
ordinary. In this form the entries don't have to match the lists. You use 
this form to enter Matings between dogs of different breeds, Matings between 
one of your dogs and one that is not in the program or to record a heat when 
the dog was not bred so that the Heats Due report will be updated correctly 
etc.
Data Entry Full
Views Allowed Form Only
Printing No need to print this form.
Normal Sort 
Order

This form always opens to a new record but it also 
contains all of the regular matings that were entered. 
These Records are sorted by Date Bred in Descending order 
(last bred is shown first) each time the form is opened 
regardless of the order they were entered.
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Matings between 
2 different 
breeds

When you are entering matings between 2 different breeds 
that you have in the program you will still want to 
choose the names from the lists so that the mating record 
will be recorded on their records. When you choose the 
breed for this type of mating it doesn't have to be the 
same as either dog. For example if you are mating a male 
Poodle to a F Cocker Spaniel you would probably want to 
enter the mating for the breed Cock A Poo. If so you will 
need to add the breed Cock A Poo in the Breeds form prior 
to entering the mating record.

Mating to a dog 
not in the 
program

When entering a mating to a dog that is not in the 
program you would want to choose your dog from the list 
and then just type in the other dog's name. However you 
will not be able to print pedigrees or Litter 
applications for this mating since both dogs are not in 
the program. If you want those options you would need to 
add the dog that you don't own to your records. After you 
have entered the mating you could go back and mark his 
status as "Other".

Skipping a Heat You can add a mating record for a dog who was not 
actually bred. You just select the dam from the list and 
then enter a message in the sire field like "skipped this 
heat". This will add the record to the dog's mating 
record and keep her next heat due updated. You would want 
to enter a note on the related litter record and mark it 
as completed.

Puppies - Entry
This is where you complete the puppy sales information and do searches for 
puppies.
Data Entry Edit, The puppies must be added to the bottom section of 

the Litters and Puppies form before they will show up 
here. You just complete the records in this form.

Views Allowed Form or Datasheet View
Printing Records may be printed in Form or Datasheet View but you 

will most likely want to print the entire Litter Record 
or Medical Record. When you use the Print button on the 
form it will print all of the records.

Normal Sort 
Order

These Records are sorted by Date Bred, Breed and in the 
order they were entered on the Litters and Puppies form 
each time the form is opened regardless of the order they 
were entered.

Filters When you open the form it contains only the puppies for 
the litter you were on in the Litters and Puppies form. 
You may use the Buttons on the form to Show All Records 
or to Show only the Puppies On Hand. You may like to use 
this form rather than the regular Puppies on Hand form. 
This one has larger print but uses more paper.

The View Litter 
Record Button

This form has a "View Litter Record" Button on each 
record. This button will take you back to the Litters and 
Puppies form and move to the record for the puppy you 
were on in this form. This is handy if you have opened 
this form to do a search for a puppy and then you want to 
see the related Litter Record.
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Searching for a 
Puppy

To search for a puppy when you don't know what litter it 
is from you just click on the "Show All Records" button 
so that all puppies in the program are added, click in 
the field you want to search by (like the Pet ID#), click 
on the binoculars on the Toolbar and enter the number you 
are looking for. It will find the puppy for you and then 
if you want to come back to the Litters and Puppies form 
to see that litter you can click on the "View Litter 
Record" button for that puppy. Otherwise you can just 
click the close (arrow) button to come back to the litter 
you were on before you opened the Puppies form.

When you keep a 
puppy

When you keep a puppy you should still enter the date of 
sale and a $0 sale amount and then put a note in the sold 
to field like "Kept this pup" so the pup is taken off of 
the Puppies On Hand form. You will then need to enter a 
record in the Dog Records form for the puppy to maintain 
it's permanent record.

Litter Medical Records - Entry, Print
This is where you enter the Medical Records for the Litter. They can be 
scheduled ahead of time so they appear on the "To Do" Report or entered as 
they are completed.
Data Entry Full Entry of the Medical lines in the subform. The Main 

form section containing the Litter info can not be edited 
here, it displays the info as entered on the Litters and 
Puppies Form.

Views Allowed Form View Only.
Printing May be printed in Form view. The Print button on the form 

prints just the Medical Record you are viewing when you 
click on it.

Normal Sort 
Order

The Medical Records are sorted by date each time the form 
is opened regardless of the order they were entered.

Filters When you first open this form it will show only the 
record for the Litter whose record you were on in the 
Litters and Puppies - Entry form. If you want to browse 
through the Medical Records for all of your Litters just 
click on the "Show All" button.

Status Field You have to choose either Done or To Do in this field. 
All records entered as To Do will appear on the To Do 
Reports until they are changed to Done.

Administered You may select entries from the list or type whatever you 
want in this field. The list shows items entered in the 
Medical Entries List Form which can be opened from the 
Master Lists Menu. This can be Vaccines, Medications, Vet 
Exams, Procedures like docking tails or removing dew 
claws, supplements given or whatever you need a record of.

The Routines  If you use a basic routine (Vaccination Schedule) for 
your litters you may use the Routine buttons to build 1 
or 2 basic medical routines that can be inserted for any 
litter. Once a routine has been inserted you may still 
add other entries or edit the records as needed.

The Age/Date 
chart

There is a chart on the form that shows you the date that 
your puppies will be various ages. This is just a 
reference chart that is calculated from the date of birth 
that you entered.
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Blank Lines If you have blank lines in the medical records or the 
Routines it is because you have removed information from 
lines but you did not actually delete the entire line. 
Blank lines are removed completely if you delete the line 
correctly. To Delete them just click on the record 
selector (the gray box on the left edge of the line) so 
that it is darkened (selected) and then press the DEL key 
on the keyboard and it will delete the line.

Tip You may want to schedule things to be done so that when 
you provide a Customer Pet Record with a puppy the new 
owner will not only have a record of what has been done 
but also know what they need to do for the puppy. You may 
even want to require that the scheduled items be carried 
out for the contract to remain in effect.

Medical Routine - Entry
This is where you set up a Routine (Vaccinaton/Medical Schedule) to be 
reused for your litters. You may design 2 Different Routines to be used. You 
may insert one or both for any litter at any time. They may be inserted 
before or even after other Medical records have been entered for the litter. 
They will just be added and arranged by date (when you reopen the form) with 
what is already there.
Data Entry Full, on the Medical Lines
Views Allowed Form View Only
Printing No need to print this form.
Normal Sort 
Order

The Medical Records are sorted by # of Days each time the 
form is opened regardless of the order they were entered.

Administer You may select entries from the list or type whatever you 
want in this field. The list shows items entered in the 
Medical Entries List Form which can be opened from the 
Master Lists Menu. This can be Vaccines, Medications, Vet 
Exams, Procedures like docking tails or removing dew 
claws, supplements given or whatever you need a record of.

Litter Records, Landscape or Portrait - Print Only
This form is designed just for printing the permanent records for your 
Litters and Puppies.

The records can not be edited in this form. Each record contains the 
information that was entered in the Litters and Puppies - Entry form.
Filters When you first open this form from the Litters and 

Puppies - Entry form it will show only the record for the 
Litter Record you were on in the Litters and Puppies - 
Entry form. If you open this form from the Dog Records - 
Entry Form it will contain all litters related to the Dog 
whose record you were on in the Dog Records - Entry Form 
and you may scroll through them.  If you want to browse 
through the Records for all of your Litters just click on 
the "Show All" button.
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Litter Pen Cards - Print Only
This form was designed to print 3x5 or 4x6 index cards to place on your dog 
pens. 

These records can not be edited in this form. Each record contains the 
information that was entered for the Litter in the Litters and Puppies - 
Entry form.
Printing Use the "More" button in the Print Setup to adjust the 

margins, columns and spacing. You may print the cards on 
a variety of card or paper sizes simply by adjusting the 
Print settings. The printed area of the pen card is 3" x 
5". Some printers must allow 1/2" space on all sides so 
you may need to use 4" X 6" cards or larger. Always check 
the Print Preview and print to plain paper to make sure 
you have the settings correct before printing to actual 
cards.

Filters When you first open this form it will contain only the 
card for the Litter Record you were on in the Litters and 
Puppies - Entry form. If you want to browse through the 
Records for all of your Litters just click on the "Show 
All" button.

Tip If your printer does not like printing on the cards or 
you have trouble getting the margins adjusted correctly 
you can purchase 8.5"X11" cardstock to print multiple 
records on and cut them to the size you want.

Tip If you would like to see more or different info on your 
pens you may want to purchase shop ticket holders which 
come in a variety of sizes that will hold even full size 
pages. They are made of tough transparent plastic and 
some have ziplock closures to keep out moisture. You can 
purchase them at most office supply stores and keep any 
printouts or records you like on your pens.

Collar Slips - Print Only
This form was designed to print collar inserts for your puppies. There are 2 
of these forms that are identical except for the Litter Registration Number 
that prints on the collars. One is for collars displaying the Reg.#1 entered 
for the puppies and the other one displays the Reg.#2 entered for the 
puppies. All other info on the collars are the same.

These are for inserting into the Animal ID bands that can be purchased from 
Precision Dynamics Corp. 1-800-255-1865, www.visaband.com or through various 
vaccine suppliers.

These records can not be edited in this form. Each record contains the 
information that was entered for the Puppies in the Litters and Puppies - 
Entry form.
Printing Use the "More" button in the Print Setup to adjust the 

margins, columns and spacing. You may print the collars 
on the slips that come with the collars or a variety of 
card or paper sizes simply by adjusting the Print 
settings.  Some printers are not capable of printing to 
narrow sheets such as the inserts sheets that come with 
the collars so you may need to print on regular paper or 
cardstock and then cut to insert.

60



Filters When you open this form from the Litters and Puppies - 
Entry form it will contain only the collars for the 
Litter Record you were on in the Litters and Puppies - 
Entry form. If you open this form from the Puppy Sales 
Invoice it will contain the records for all Puppies sold 
on the date of the invoice.

Litter Pedigrees - Print Only
The Pedigree forms were designed for Printing Only. 

The records can not be edited here. Each record contains information that 
was entered on the Dog Records - Entry,  the Continue Sire Pedigree and the 
Continue Dam Pedigree forms for the Dam and Sire of the Litter. If this 
pedigree does not display the correct information you will need to go back 
and correct those records. The Owner Information that is displayed in the 
top left corner is what you have entered in the Kennel Owner Detail form 
which you open from the People Menu. If it does not display here as you like 
you will need to open and edit that record.

The Litter Pedigrees are designed to print for the litter. There are areas 
on the Pedigree that may be filled in by hand with individual puppy 
information like Sex, Color and Registration ID but these areas can not be 
edited in the program.
Filters When you first open this form it will contain only the 

Pedigree for the Litter you were on in the Litters and 
Puppies - Entry form. If you want to browse through the 
Records for all of your Litters just click on the "Show 
All" button.

Custom Borders 
and Watermarks

We have designed 4 & 5 Generation Pedigree choices for 
the Litters that you may print with or without a border. 
The reason we gave you the option of printing them 
without the border is so that you could design your own 
if you like. To use custom borders or watermarks you may 
purchase or design and print the borders and backgrounds 
of your choice and then simply print these pedigrees 
without the border onto your custom designed sheets.

E-Mailing a 
Pedigree

This program does not have the ability to e-mail directly 
from the program but there is a way to do it. We use a 
utility called ScreenPrint which is a screen capture 
utility that runs in the background and allows you to 
capture anything on your screen at any time. Once you 
capture something you can e-mail it, save it, Print it, 
Edit it like a picture or whatever you want to do with 
it. You can download ScreenPrint from 
www.softwarelabs.com or choose from a variety of other 
screen capture utilities on the market.

Saving Changes 
to the Form

If you change the print settings for the form you will be 
asked if you want to save the change when you close the 
form. Sometimes if you choose yes you will get an error 
stating "Cannot Destroy Active Form Instance" If you get 
that error you can use the X button on the top right 
corner of the form to close it instead of the arrow 
(close) button to close the form and you won't get an 
error... We don't know why it does that but it sometimes 
does...
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Customer Pet Record and Contract - Edit, Print
This is the form you will use to print records to be given to your customer 
when you sell puppies privately. These records include the Customer 
Information, Pet Identification, the Contract Terms and the Medical Records 
for the Sale of a Puppy.
Data Entry Edit, This form displays information entered for each 

Puppy in the Litters and Puppies form, the Puppies form 
and the Litter Medical Records form.

Views Allowed Form View Only
Printing May be printed in Form View Only.  The Medical record 

area and the Guarantee area of the form will expand when 
printed to include all information contained in those 
sections. The Print button on the form prints only the 
current record. You should print 2 copies of this record 
and both should be signed by all, one for you and one for 
the customer

Normal Sort 
Order

These records are in the order they were entered on the 
Litters and Puppies form each time the form is opened.

Filters When you open this form from the Litters and Puppies form 
it will contain a record for each puppy that is entered 
in the Litter your were on in the Litters and Puppies 
form. If you want to see the records for all of your 
puppies you can choose Records, Show All Records from the 
Menubar.

Inserting the 
Contract Terms

At the top of the form there is a List field where you 
select the Contract ID for the Contract Terms that you 
want to be inserted into the Guarantee area.

Additional Terms You may enter additions or amendments to the standard 
contract terms in this area.

Puppy Sales Invoice / USDA 7006 - Entry, Print
Use this invoice for Sales of Multiple puppies. This invoice is accepted by 
USDA in place of their form 7006. Just complete one and send it to the main 
office for approval.
Data Entry In this form to add a record you simply go to a new 

record and enter the date of sale, the invoice # and then 
select the appropriate purchaser in the sold to List. The 
appropriate puppies will be added automatically based on 
matching sales info you have entered in the Puppies form 
for the puppies.  All Puppies (even from multiple 
litters) with a matching date of Sale and Sold to the 
same person will be added to the invoice.

The Invoice # You may enter your invoice numbers however you like. If 
you don't have a particular number or sequence you want 
to use we suggest you use the assigned number at the top 
of the form as the invoice number. The assigned number 
will never be duplicated. It is actually the number 
assigned to the record by the program.

Additional 
Charges

You may also enter other fees on the lines below the 
puppies. Each line has a description field and $ amount 
field. These amounts will be added to the Total on the 
invoice.
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Transported By 
and Truck 
Driver Fields

These fields were added to make the form compatible with 
the USDA 7006 form as they require this information to be 
entered.

Missing Puppies If you have entered an invoice and there are puppies 
missing that should be showing up on the invoice you need 
to check the following things. First make sure the date 
of sale and the person sold to on the puppy's record is 
correct. If it appears to be the same but the puppy does 
not show up then go back to the puppy record and remove 
the name and address of the person you sold the puppy to 
and then select it from the list. Tip: When you are 
selecting the name of the purchaser on the Invoice, if 
their name is in the list more than one time it means the 
entries are not an identical match. The computer sees 
them as different people if the entry is not exactly the 
same. To prevent or correct this problem you need to 
always choose the name of the person you are selling 
multiple puppies to from the list for the Puppy Sales 
records. Then it will only be listed on the invoice "Sold 
to" list one time and when you select it all puppies will 
show up correctly.

Can't save or 
print, I get a 
message that 
says Duplicate 
Value...

If you get a message that the record can't be saved or 
that it is a duplicate value it means that you have 
already entered an invoice for the same date to the same 
purchaser. Just press your Esc key on the keyboard 2 
times to undo the record you can't save and then scroll 
through and find the one that is already there.

Records entered 
on the USDA 
7006 form in 
previous 
versions

In previous versions we had this form and a form designed 
for printing the records right on the usda 7006 forms 
that USDA provided. Both forms use the same records so 
any records you had entered on that form are still in 
this form. We removed the other one because it was hard 
to get it set up to print correctly and since USDA 
approves this one which is much simpler there was no need 
to have both.

Litter Registration Options - Menu
This is where you print Litter Registrtion Applications for the 4 Registries 
we have made available. There are Litterally hundreds of Registries out 
there and we can not include the litter apps for all of them so we have 
decided to limit this option to just the Top 4 regsitries used by our 
customers.
Why 2 choices 
for each 
Registry

When printing a litter app for a registry you will choose 
button 1 or 2 for the app based on the way your dog 
registration numbers have been entered. For example if 
you have entered APRI as registration 1 for your adult 
dogs and UABR as Registration number 2 then when you want 
to print a litter app for APRI you would select APRI 1 
and when you want to print a litter app for UABR you 
would select UABR 2 to print the correct registration 
numbers for the dogs on the litter app.

Optional Fields There is a button at the top of the screen to open a form 
which allows you to enter information that will display 
on the litter apps like Phone numbers, e-mail, credit 
card info etc.. You need to remove the sample info and 
add your own or leave things blank if you don't want it 
printed on the litter apps.
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The Litter App 
is blank

If the litter app for the record you want comes up blank 
then you need to go back to where the mating info was 
entered on the Litters and Puppies form and repick the 
information in the mating section from the lists. There 
will not be a litter app available if both dogs are not 
picked from the list or where the owners don't match the 
list. If you picked the entries from the list when you 
entered the mating and the litter app is blank now then 
something in the Dog or people records entered has been 
changed since then so you need to repick the entries to 
show the changes. If everything matches the lists then 
the litter app will show up.

Puppy Requests - Entry, Print
This is where you keep track of potential buyers and who is looking for what.
Data Entry Full
Views Allowed Form Only
Printing May be printed in Form View.
Normal Sort 
Order

These records are in the order they are entered when the 
form is opened.

Prices displayed The Current Retail and Wholesale prices shown are the 
prices you have entered for the selected breed in the 
Breeds Form. They are shown here for reference only.

Puppies On Hand Report - Edit, Print
This Report/Form is designed to print a list of your Puppies on Hand.
Data Entry Edit, not all fields can be edited in this form.
Views Allowed Form or Datasheet
Printing May be printed in Form or Datasheet View. The font is 

really small on the Form View to fit everything in it. 
You may want to use the Datasheet View to enlarge the 
fonts if you don't need to see all of the fields.

Normal Sort 
Order

These records are sorted by Pet ID# when the form is 
opened regardless of the order they were entered.

Filters There are button on the form to Show All Records or to 
view just the Puppies On Hand.

Litters TO-DO Report - Print Only
This report includes all Litter Medical Record entries with a To Do Status.

Puppy Sales Report - Print Only
This Report will ask you for a beginning date and an ending date when you 
open it. Once it opens it will show you all Puppy Sales that occurred during 
that time frame and a Balance.
Note You must enter the Date Sold or Died, and Sale price for 

all puppies in the Puppies form in order for this report 
to be accurate. The report also includes info from the 
Kennel Owner Detail form.
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8 Week Old Report - Print Only
This Report lists all puppies under 8 weeks old and shows the date that they 
will be 8 weeks old, the breed, dam, sex, color, the date of birth and the 
type of registration for each.
Note You must enter the Date Sold or Died, and Sale price for 

all puppies in the Puppies form in order for this report 
to be accurate. The report also includes info from the 
Kennel Owner Detail form.

Puppy Loss Report - Print Only
This Report will ask you for a beginning date and an ending date when you 
open it. Once it opens it will show you all Puppy Lost during that time 
frame.
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Our Motto is: 

JESUS and  
a Puppy can Lick 

Anything!!! 
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